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Safety Information

The safety information section provides information on the safe use of the instrument. It
includes the use of user-attention statements in this guide, a key to understanding the
safety labels on the instrument, precautions to follow before operating the instrument, and
precautions to followwhile operating the instrument.
Read and observe all warnings, cautions, and instructions. Remember, themost important
key to safety is to operate the instrument with care.

WARNING! If the instrument is used in a manner not specified by Molecular
Devices, the protection provided by the equipment might be impaired.

Warnings, Cautions, Notes, and Tips
All warning symbols in the user guide are framed within a yellow triangle. An exclamation
mark is used for most warnings. Other symbols can warn of other types of hazards such as
biohazard, electrical, or laser safety warnings as are described in the text of the warning.
When warnings and cautions are displayed in this guide, be careful to follow the specific
safety information related to them.
The following user-attention statements can be displayed in the text ofMolecular Devices
user documentation. Each statement implies a particular amount of observation or
recommended procedure as described:

WARNING! A warning indicates a situation or operation that could cause
personal injury if precautions are not followed. Some warnings can have a
different symbol on the left, such as electric shock, biohazard, and laser light
warnings. The definition of the symbol is included in the text of the warning.

CAUTION! A caution indicates a situation or operation that could cause damage to
the instrument or loss of data if correct procedures are not followed.

Note: A note calls attention to significant information.

Tip: A tip provides useful information or a shortcut, but is not essential to the
completion of a procedure.
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Symbols on Instrument Labels
Each safety label found on the instrument contains an alert symbol that indicates the type of
potential safety hazard related to the label. The following table lists the alert symbols that
can be found on Molecular Devices instruments.

Symbol Indication

This symbol indicates that the product documentation must be consulted.

This symbol on the product is required in accordance with the Waste Electrical and
Electronic Equipment (WEEE) Directive of the European Union. It indicates that you
must not discard this electrical or electronic product or its components in domestic
household waste or in the municipal waste collection system.

For products under the requirement of the WEEE directive, contact your dealer or
local Molecular Devices office for the procedures to facilitate the proper collection,
treatment, recovery, recycling, and safe disposal of the device.

Table S-1: Instrument Label Alert Symbols

Before Operating the Instrument
Make sure that everyone involved with the operation of the instrument has:

Received instruction in general safety practices for laboratories.

Received instruction in specific safety practices for the instrument.

Read and understood all Safety Data Sheets (SDS) for all materials being used.

Protective Housing and Safety Interlocks
The protective outer housing and instrument interlocks are designed to protect you from
exposure to laser light, hot surfaces, or moving parts.
The automated top door is interlocked. Do not operate this instrument with the top door
open. Do not disable an interlock. When the automated top door is open, the laser light
source is disabled to prevent hazards associated with laser emission.

WARNING! Do not defeat any interlocks, open the protective housing, or try to
gain access to the interior of the instrument through any other openings, unless
specifically instructed by one of the user procedures in this guide. Read each
procedure carefully and follow all safety precautions. Incorrectly opening the
outer protective housing can damage the instrument components and result in
hazardous exposure to laser light, hot surfaces, or moving parts.
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Safety Interlock Failure

If the focusing laser stays on when the automated top door is open, it is unsafe to continue
using the instrument due to a safety interlock failure. Contact Molecular Devices Support
immediately. See Obtaining Support on page 149.

Non-Interlocked Doors and Panels

The side access doors are not interlocked. These doors do not provide access to exposure by
the laser light source. Somemoving parts exist inside these doors. SeeMoving Parts Safety
on page 10.
The instrument has several panels that are intended for use by field service personnel only,
and are not interlocked. All service panels are secured to the protective housing with screws
and require a special tool to remove.

WARNING! If you are instructed to remove non-interlocked panels, make sure
that the instrument is powered OFF and the power cable is unplugged. Never
operate this instrument with any covers or panels removed. Do not attempt to
access the service-only areas inside the instrument when the power cable is
connected.

Laser Safety

WARNING! LASER LIGHT. This symbol indicates that a potential hazard to
personal safety exists from a laser source. When this symbol appears in this guide,
follow the specific safety information related to the symbol.

Item Description

Wavelength 690 nm

Maximum output power 20 mW, continuous wave

Laser class Class 3b

Table S-2: Embedded Laser Module Specifications

The operator or the service engineer is not exposed to radiation from the laser module
during operation, maintenance, or service. If the top panel is removed for service, the laser
beam remains safely contained within the optical system until it passes through the
microscope objective, which diverges the beam and renders incident power levels below
Class 1 (1 mW/cm2).

WARNING! LASER LIGHT. Operate the instrument only when all the doors and
panels of the instrument are in place and closed.
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Light Source Safety
The ImageXpress Nano System is equipped with an external light source connected to the
instrument with a light guide.
The ImageXpress Nano System light source is a solid-state source that has a rated lifetime of
more than 10,000 hours. There are no user-replaceable parts in this light source.

Electrical Safety
To prevent electrically related injuries and property damage, properly inspect all electrical
equipment before use and immediately report all electrical deficiencies. Contact Molecular
Devices technical support for servicing of equipment that requires the removal of covers or
panels.
Molecular Devices recommends that you power off the instrument when it is not in use.

WARNING! The ImageXpress System is an Equipment Class 1 product that relies
on protective earth grounding for safe operation. Any interruption of the
protective earth ground conductor, inside or outside the instrument, or
disconnection of the protective earth ground terminal can result in personal
injury.

WARNING! Do not position the equipment so that it is difficult to operate the
power switch on the front of the ImageXpress Systems Power and Options
Controller.

WARNING! HIGH VOLTAGE. Do not operate the external light source with the
external light source housing open. Do not open the external light source housing
with the light source powered on.

Fuses and Circuit Protection

In the ImageXpress Nano System, the ImageXpress Systems Power and Options Controller
provides over-current protection for the light source limited to 15 amps maximum. The
power controller contains no user-serviceable parts.

Moving Parts Safety
The instrument contains moving parts that can cause injury. Under normal conditions, the
instrument is designed to protect you from thesemoving parts.
To prevent injury:

Never try to exchange labware, reagents, or tools while the instrument is operating.

Never try to physically restrict themoving components of the instrument.
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WARNING! Do not attempt to access the interior of the instrument unless
specifically instructed to do so. The moving parts inside the instrument can cause
injury. Do not operate the instrument with any covers or panels removed.

Note: Observe all warnings and cautions listed for all external devices attached to or in
use during the operation of the instrument. See the applicable user guide for the
operating and safety procedures of that device.

Lifting Hazard

CAUTION! Moving the instrument can disrupt sensitive optical alignments. Molecular
Devices recommends that you contact Technical Support to schedule a Field Service
engineer to help with moving your instrument. Your warranty or service contract does
not cover problems caused during or as a result of shipment or relocation.

Chemical and Biological Safety
Normal operation of the instrument can involve the use ofmaterials that are toxic,
flammable, or otherwise biologically harmful. When using such materials, observe the
following precautions:

Handle infectious samples based on good laboratory procedures and methods to
prevent the spread of disease.

Observe all cautionary information printed on the original containers of solutions before
their use.

Dispose of all waste solutions based on the waste disposal procedures of your facility.

Operate the instrument in accordance with the instructions outlined in this guide, and
take all the required precautions when using pathological, toxic, or radioactivematerials.

Splashing of liquids can occur. Therefore, take applicable safety precautions, such as
using safety glasses and wearing protective clothing, when working with potentially
hazardous liquids.

Observe the applicable cautionary procedures as defined by your safety officer when
using hazardous materials.

Observe the applicable cautionary procedures as defined by your safety officer when
using flammable solvents in or near a powered-up instrument.

Observe the applicable cautionary procedures as defined by your safety officer when
using toxic, pathological, or radioactivematerials.
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WARNING! Never use the instrument in an environment where potentially
damaging liquids or gases are present.

Cleaning and Maintenance Safety
Observe the cleaning procedures outlined in this guide for the instrument.
Do the following before you clean equipment that has been exposed to hazardous material:

Contact the applicable Chemical and Biological Safety personnel.

Review the Chemical and Biological Safety information contained in this guide. See
Chemical and Biological Safety on page 11 for details.

Do only themaintenance described in this guide. Maintenance procedures other than those
specified in this guidemust be done by qualified Molecular Devices personnel only.

WARNING! BIOHAZARD. It is your responsibility to decontaminate
components of the instrument before you return parts to Molecular Devices for
repair. Molecular Devices does not accept items that have not been
decontaminated where it is applicable to do so. If parts are returned, they must be
enclosed in a sealed plastic bag stating that the contents are safe to handle and
are not contaminated.

For approved cleaning and maintenance procedures, seeMaintenance on page 141.
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Chapter 1: Introduction to the ImageXpress Nano System

The ImageXpress® Nano Automated Imaging System from Molecular Devices is an integrated
cellular imaging and analysis system that is designed for rapid, automated screening of
fluorescently labeled biological samples in microplates. With the addition ofmodular
options, the system provides environmental control for live cell imaging and uses
transmitted light capability for label-free imaging.
The core hardware component of the imaging system is a custom-designed, fully automated,
epi-illumination fluorescencemicroscope. The rapid autofocus and precision sample
movement features of themicroscope allow large numbers of high-resolution images to be
acquired in the shortest possible time. All key optical and mechanical elements are
motorized, with asynchronous command execution, allowing complete real-time control of
the instrument configuration through the MetaXpress High-Content Image Acquisition and
Analysis Software.
When used in combination with the powerful image analysis capabilities of theMetaXpress
Software, the instrument becomes an extremely flexible and programmable device, ideally
suited for user-defined, high-speed automated assays.
Key components of the instrument include the following:

External solid-state white light source connected by a liquid light guide

A CMOS camera

Laser autofocus system with precision motorized Z (focus) stage

Image-based autofocus

Precision motorized X-Y (sample) stage

High-quality, Nikon objectives in a four-position linear selector

Filter cubes in a five-position slider

Motorized selection of stage position, and objectives with asynchronous operation

High-transmission fluorescence imaging optics with chromatic aberration correction,
resolution, and image flatness

Operation and configuration control by the integrated MetaXpress Software

Optional expansion solutions available for environmental control and transmitted light

1



ImageXpress Nano System with MetaXpress Software User Guide

14 5058342 B

ImageXpress Nano System Instrument Features

Figure 1-1: ImageXpress Nano System Components Without Options Using MetaXpress®
Software

Illumination System: Excitation

Light Source
The ImageXpress Nano System light source is a solid-state source that has a rated lifetime of
more than 10,000 hours. There are no user-replaceable parts in this light source.

Note: The ImageXpress Nano System solid-state light source is limited to an excitation
spectrum ranging between 380 nm and 680 nm.

Illumination Optics
The output end of the liquid light guide is imaged onto the sample by a set of internal optics
and the objective, providing bright and uniform illumination of the specimen over a wide
field of view. This constitutes an Abbé illumination system (also called critical illumination).

Filter Cube Changer
The 5-position filter cube changer takes standard Nikon TE2000 filter cubes. The system uses
Semrock filters.
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Objective (Z) Stage

Motorized Z Stage
The Z stage position is monitored using a linear encoder that features better than 100 nm
resolution.

Objectives
The standard objectives are Nikon CFI60 series. The selected objective lens focuses excitation
light onto the sample, and collects fluorescence light emitted by the sample. Molecular
Devices offers a wide range of objectives to suit your experimental needs. See Compatible
Objectives, see page 159.

Motorized Objective Changer
The instrument includes a 4-position objective changer. Only the selected objectivemoves
up and down when the position is changed.

Sample (X-Y) Stage

Sample
The plate holder is designed for scanning multi-well microplates in standard ANSI (SBS)
formats with plastic or glass bottoms. It can accommodate other plate formats that have
standard microplate footprint dimensions. For example, glass slides can be imaged using a
slide adapter included in the accessory kit. Optimal image quality depends on plate flatness,
well bottom thickness, and optical clarity.

Plate Holder and Plate Clamp
A spring-loaded mechanical clamp holds the sample plate securely in the plate holder. The
clamp automatically opens when the X-Y stagemoves to the load/eject position, and
automatically closes when the X-Y stagemoves the plate into position for imaging.

Motorized X-Y Stage
The X-Y stage position is monitored using a linear encoder that features better than 100 nm
resolution.

Autofocus Laser

A red (690 nm) diode laser projects a laser spot onto the sample. Reflections of this spot from
the bottom of themicroplate and the plate-sample interface are imaged by a dedicated,
fast-focus sensor, and are used as a reference for focusing using the autofocus feature of the
MetaXpress Software.
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Electronics

Without optional equipment, the ImageXpress Nano System includes the following
additional components:

External ImageXpress Systems Power and Options Controller and cables

External solid state light source, fiber, and cables
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MetaXpress Software Features
Use theMetaXpress Software with the ImageXpress Nano System to select a standard
acquisition and analysis protocol or to develop a custom protocol to fit your specific
acquisition and analysis needs. TheMetaXpress Software workflow is divided into two major
parts: acquisition and analysis.

The acquisition workflow involves configuring settings, acquiring images, and storing
plate data in a database. See Preparing For Acquisition on page 43 and Configuring Plate
Acquisition Options on page 49.

The analysis workflow consists of processing, enhancing, and analyzing acquired plate
data. See theMetaXpress High-Content Image Acquisition and Analysis Software
Analysis Guide included on theMetaXpress Software Suite installation USB flash drive, or
the application help available when using theMetaXpress Software.

Simplified Menu Structure

New systems ship with the simplified menu installed, otherwise as an option, the simplified
menu structure can be installed to reduce the number of top-level menus in theMetaXpress
Software. All the features of the software are available in this reorganized menu structure.
The procedures in this guide describe both the default menu structure and the simplified
menu structure.
You can use theMenu Map in theHelpmenu to help you find the locations of features in the
simplified menu structure. TheMenu Map is available only after the simplified menu
installation.

1. Click Help > Menu Map.

2. In theMenu Map dialog, select to view theDefault to customized menumap.

3. Click themenu path where the software feature you want is found in the default menu
structure.
The simplified menu path appears to the right of the desired feature in themenu.

4. Click themenu path in the software window to access the desired feature.
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For example, if you want to make a duplicate of an image, then use the following procedure:

1. Click Help > Menu Map.

2. In theMenu Map dialog, select to view theDefault to customized menumap.

3. Click Edit > Duplicate.
The simplified menu path -> Edit: Image: Duplicate Image/Plane appears to the right of
the Image option in the submenu.

4. In the software window, click Edit > Image > Duplicate Image/Plane.

Administrator Tasks

Most of the procedures in this guide are for general users. However, Molecular Devices
recommends that you identify one or more users as advanced users or system
administrators. The responsibilities of the system administrator vary from site to site.
Variables include the number of users on the system, the type of database used, and the
type of work done. Some common MetaXpress Software system administrator tasks
include:

Installation overviewwith a Molecular Devices representative

Post-installation hardware and software testing

Database planning and implementation

Custom user and group settings creation

Maintenance scheduling and software updating
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Theory of Operation

Figure 1-2: ImageXpress Nano System Optical Path
The ImageXpress Nano System uses the following components and functions:

Fluorescence Imaging, see page 19

Excitation and Emission Filters, see page 20

Objective Lenses, see page 21

Fluorescence Imaging

Fluorescence is a property of certain classes ofmolecules (fluorochromes, fluorescent
proteins, or dyes) in which photons of a specific wavelength are absorbed (excitation), and as
a result a very short time later photons are emitted at a longer wavelength (emission). The
utility of fluorescence imaging in biological applications stems from the ability to conjugate
fluorescent molecules with biologically active probemolecules, so that application of the
combined dye/probemolecule (fluorophore) to the specimen highlights the specific
substances or regions to which the probe is targeted.
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By attaching different probes to a set of dyemolecules with non-overlapping excitation and
emission spectra, one can stain a specimen with multiple fluorophores, and either
simultaneously or sequentially image different structures or substances within the same
specimen. The absorption and emission peaks for each dye or fluorescent protein in a given
environment are physical characteristics of that molecule, and their specific properties
determine the initial selection of the optical components to be used, such as the emission
and excitation filters, and the dichroic mirror.

Excitation and Emission Filters

To selectively excite one fluorophoremore intensely than another, or to minimize excitation
channel crosstalk, it is necessary to provide illumination containing only photons with a
wavelength rangematched to the absorbance (excitation) spectrum of the target dye. A
bandpass filter in the illumination optical path (called the excitation filter, since it filters the
excitation light) is used to restrict the illumination spectrum to a narrow range of
wavelengths.
Similarly, when imaging the illuminated sample, it is desirable to collect only the emission
photons from the target fluorophore, rejecting as much as possible any reflected or
scattered excitation light, any light from other dyes, and autofluorescence from the sample
and substrate. This is done by placing a filter in the collection light path, called the emission
filter. Emission filters can either be of the bandpass variety, for maximum specificity, or
longpass, to maximize the amount of emission light collected.

Dichroic Mirror

A dichroic mirror is a specially designed beam splitter that transmits light above a certain
cutoff wavelength, and reflects light at shorter wavelengths. This is the essential component
that allows the construction of an epi-illumination fluorescence imaging system in which the
illumination and imaging optical paths overlap at the objective lens. The same objective lens
is used to focus the illumination light onto the sample as well as collect the emitted
fluorescent light to form the image.
In the illumination path, the dichroic mirror reflects shorter wavelengths from the light
source up through the objective onto the specimen.
In the imaging optical path, longer wavelength fluorescence light emitted by the excited
fluorophores in the specimen is collected by the objective lens, and transmitted through the
dichroic to the camera. Incident light from the sample that is shorter wavelength than the
cutoff (mostly reflected illumination light from the sample) is reflected by the dichroic (and
further blocked by the emission filter), and is therefore prevented from entering the imaging
system of tube lens and camera.
All of the optics in the filter cube are interference filters made by depositing a number of thin
film coatings on a glass support. They are delicate and easily damaged components. Use care
when handling these components.
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Dichroic Transmission Spectrum

An ideal dichroic mirror would have an infinitely sharp cut-off. That is, it would have unity
transmittance coefficient at wavelengths longer than the cut-off, and zero transmittance
(and therefore unity reflectance in a non-absorbing dichroic mirror) at shorter wavelengths.
In practice, the characteristic transmission spectrum for a dichroic looks similar to the graph
in Figure 1-3.

Figure 1-3: Example of a transmission spectrum of a dichroic mirror
In principle, the cutoff wavelength (or midpoint of the cutoff region) of the dichroic mirror
should be chosen to lie halfway between the absorption and emission peaks of the chosen
fluorochrome, as this simultaneously maximizes the amount of excitation light available at
the sample, and also the amount of collected fluorescence emission that is transmitted to
the camera. In practice, however, additional considerations such as fluorochrome efficiency
can dictate that the cutoff region is biased toward one peak or the other. This allows, for
example, greater transmission of longer wavelength image photons at the expense of less
reflection of shorter wavelength excitation light.

Objective Lenses

The ImageXpress Nano System can be configured at the time of purchase with up to 4 of the
high quality Nikon objectives listed in Compatible Objectives on page 159.

Note: Extra-long working distance (ELWD) objectives have adjustable
spherical-aberration correction collars for imaging through thick substrates such as
most microplates. For details on how to calculate and set their correct values, see
Adjusting the Spherical-Aberration Correction Collar on ELWD Objectives.

Several of the other objectives (such as, 40x Super Plan Fluor ELWD) also have correction
collars for adjustment according to the thickness of the glass cover slip or thin plate bottom
being used. Setting these collars should be done using the physical thickness of the plate
bottom or through optimization of image quality.
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Objectives are classified according to optical correction, flatness of field, numerical aperture,
and working distance. It is important to consider the types of plates and type of assay that
you will be imaging. The platematerial (plastic or glass) and thickness aremajor
considerations when choosing an objective. Another important practical note is that
generally the greater the correction of an objective, the greater the number of lens elements
it contains, with correspondingly reduced light transmission, especially in the UV spectrum.
In particular, apochromatic (Apo) objectives tend to have poor UV transmission
characteristics.
For detailed information on objectives, please see the Nikon web site (www.nikon.com).

http://www.nikon.com/
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Chapter 2: Using the ImageXpress Nano System

This section provides a quick overview of the start-to-finish workflow for using the
ImageXpress Nano System. The following topics are included in this section:

Starting the System on page 23

Acquiring Data on page 26

Analyzing Data on page 26

Maintaining the Instrument on page 26

Starting the System
The following procedures explain how to safely power on the instrument and computer and
how to start and log in to theMetaXpress Software.

Powering On the Instrument on page 23

Starting the Software on page 24

Powering On the Instrument

Before starting the software, you must power on the instrument properly using the following
procedure.
To power on the ImageXpress Nano System:

1. Ensure that the power cords for the instrument and the light source are connected to
the ImageXpress Systems Power and Options Controller, and verify that the power
button is switched on for the light source box.

2. Turn on the Instrument button on the front of the ImageXpress Systems Power and
Options Controller. This button also turns on the connected light source box.

Note: On the light source box, the power switch should be set to on and the light
override switch should be set to off.

3. Turn on the power to the host computer and themonitor.

2
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4. After the computer has started and Windows is running, log in to Windows using the
User Name and Password combination provided for you by your system administrator.

CAUTION! Do not log in to your system as Guest unless you are specifically
instructed to do so by your system administrator.

5. Start theMetaXpress Software. See Starting the Software.

Starting the Software

This procedure assumes that your ImageXpress Nano System and your MetaXpress
Software have been properly installed and configured by your Molecular Devices
representative and your System Administrator.

Note: If you encounter or observe actions or results that are inconsistent with your
expected results when using the ImageXpress Nano System and your MetaXpress
Software, contact your system administrator before continuing your experiment.

To start theMetaXpress Software:

1. Double-click theMetaXpress icon on your desktop or click Start > All Programs >
MetaXpress > MetaXpress.

2. In theMetaXpress Software login dialog, from theUser Name drop-down list, select the
user name to use and then click OK.

Figure 2-1: MetaXpress Software login dialog

Note: TheMetaXpress Software login dialog appears only when the software is
configured to run in multi-user mode from within theMeta Imaging Series
Administrator Software. If you do not see this screen, the software is in single-user
mode and the dialog in Figure 2-2 is displayed.
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3. In theWelcome to MetaXpress dialog, select theData Source to connect to (if there is
more than one), type your Login Name and Password, and then click OK.

Figure 2-2: Welcome to MetaXpress dialog

Note: default System Administrator Login Name is sa, and the default password is
moldev. You can change the password by clicking Change Password.

4. In the dialog to select a security level, select one of the groups assigned in theMDCStore
database and then click OK.

TheMetaXpress Software starts and initializes the various components of the
ImageXpress Nano System.
If you receive error messages when the system is initializing, try the following:

Check that all hardware connections are plugged in and fully seated.

Check that the plate stage is clear of blockages.

Restart the system.

If the error message continues after the recommended troubleshooting, use AxoTrace and
contact Molecular Devices Technical Support. See Logging AxoTrace SoftwareMessages to a
.txt File on page 151.

Status Indicator Lights
The status light on the front of the ImageXpress Nano System illuminates with colors that
provide information about the instrument status.

Color Instrument Status

Orange The instrument is powered on without software control.

Table 2-1: Status Indicator Colors
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Color Instrument Status

Blue The instrument is powered on with software control and is ready to use.

Green The instrument is acquiring data.

Red The instrument is in an error state or cannot communicate with the software. You must
reboot the instrument.

Table 2-1: Status Indicator Colors (continued)

If required, you can turn off the status indicator lights. See Turning off the Status Indicator
Lights on page 149.

Acquiring Data
The acquisition workflow involves configuring settings, acquiring images, and storing plate
data in a database.
For detailed information, see the following sections:

Preparing For Acquisition on page 43

Configuring Plate Acquisition Options on page 49

Analyzing Data
The analysis workflow consists of processing, and analyzing acquired plate data. See the
MetaXpress High-Content Image Acquisition and Analysis Software Analysis Guide included
on theMetaXpress Software Suite installation USB flash drive, or when using theMetaXpress
Software, view the help by selecting Help > Help Topics, or pressing F1 on your keyboard.

Maintaining the Instrument
Specific user-level maintenance can be done on the ImageXpress Nano System for cleaning
objectives, and cleaning the instrument as described in Maintenance on page 141.
Do only themaintenance described in this guide. Maintenance procedures other than those
specified in this guidemust be done by qualified Molecular Devices personnel only. See
Obtaining Support on page 149.
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Chapter 3: System Installation

The ImageXpress Nano System ships fully configured, and is installed at your site by a
Molecular Devices field service engineer. The base system includes the imaging unit, the host
computer, and accessory kit.
The ImageXpress Nano System instrument connects to the host computer during
installation.

Figure 3-1: ImageXpress Nano System Components Without Options Using MetaXpress®
Software

Power supply to the instrument

Liquid light guide from the external light source to the instrument

USB 2.0 from the light source to the instrument

USB 2.0 from the instrument to the computer for data

USB 3.0 from the instrument to the computer for camera output

3
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Accessory Description

Bead plate TetraSpeck™ fluorescent microspheres test plate

Hex keys 1/16", 0.05"

Slide holder Single

Calibration slides Spatial (GP-2)
Red (GP-7)
Green (GP-8)
Blue (GP-9)
Yellow (GP-11)

Shading correction plates Fluorescent Green
Fluorescent Red
Fluorescent Pink

Storage box Empty accessory box for miscellaneous storage use

Table 3-1: Accessory Kit Contents

Verifying Device Settings in the Meta Imaging Series Administrator Software
This procedure ensures that the ImageXpress Nano System hardware components are
properly configured in theMeta Imaging Series Administrator Software and in the
MetaXpress Software. All hardware and software configuration settings are implemented in
theMeta Imaging Series Administrator Software.

Note: Molecular Devices recommends running verification tests without a sample
plate loaded on the stage.

Note: TheMeta Imaging Series Administrator Software and theMetaXpress Software
cannot be run simultaneously.
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To verify the hardware configuration in theMeta Imaging Series Administrator Software,
complete the following procedure:

1. Follow the procedure described in , but do not start theMetaXpress Software.

2. Click Start > All Programs > MetaXpress 6 > Meta Imaging Series Administrator.

3. In theMeta Imaging Series Administrator, from List of Groups, selectMetaXpress.

Figure 3-2: Meta Imaging Series Administrator Software home dialog

4. Click Configure Hardware.

5. In the Configure Hardware dialog, click Configure Devices.

6. In theUser Settings dialog, from Claimed Devices, select ImageXpress Micro X and then
click Settings.
Figure 3-3: User Settings dialog

7. In the ImageXpress Micro X Settings dialog, in theMove field, increase the step size to
10,000 µm.

Figure 3-4: ImageXpress Micro X Settings dialog

8. Ensure that the Reverse Coordinate System check box is not selected.
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9. Click the + and – buttons and confirm that the stage responds to the control.

10. In theMove field, change the step size back to 10 µm and click OK.

11. In theUser Settings dialog, from Claimed Devices, select ImageXpress Micro Y and then
click Settings.

12. In the ImageXpress Micro Y Settings dialog, in theMove field, increase the step size to
10,000 µm.

Figure 3-5: ImageXpress Micro Y Settings dialog

13. Ensure that the Reverse Coordinate System check box is selected.

14. Click the + and – buttons and confirm that the stage responds to the control.

15. In theMove field, change the step size back to 10 µm and click OK.

16. In theUser Settings dialog, from Claimed Devices, select ImageXpress Micro Z and then
click Settings.

17. In the ImageXpress Micro Z Settings dialog, verify that the value in theDevice Units
field is 50.

Figure 3-6: ImageXpress Micro Z Settings dialog
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18. In theMove field, increase the step size to 1000 µm.

Note: Do not change the Plate Bottom Reference value.

19. Click the + and – buttons and confirm that the Z motor responds to the control.

20. Click Go to Origin.

21. In theMove field, change the step size back to 10 µm and click OK.

22. In theUser Settings dialog, from Claimed Devices, select ImageXpress Micro Objective
and then click Settings.

23. In the ImageXpress Objective Settings dialog, confirm that theObjective Labels and the
values in theNum Aperture fields match each objective on your system.
The Numerical Aperture (NA) values are written on each objective.

Figure 3-7: ImageXpress Micro Objective Settings dialog

24. In theObjective Parameters section on the bottom half of the dialog, click the Param
Group #1 tab.
This tab contains the Z offset positions in microns (µm) for the objectives.

25. Confirm that the values are valid numbers and at least one is set to zero.

26. Click the Param Group #2 tab.

27. Click Open Control Dialog.
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28. In the Control - ImageXpress Micro Objective dialog, click the arrow buttons and
confirm that the objective changer is moving appropriately.

Figure 3-8: Control > ImageXpress Micro Objective dialog

29. Click Done.

30. In the ImageXpress Micro Objective Settings dialog, click OK.

Note: If you have a plate handling robot attached to the
ImageXpress Nano System, confirm those settings as well. For information, see
Verifying External Control Settings.

31. Click OK to close theUser Settings dialog.

Verifying Camera Settings in the Meta Imaging Series Administrator Software
Complete the following procedure to ensure that the correct version of the camera driver is
installed.

1. With the powered on, make sure that theMeta Imaging Series Administrator Software is
open to the Configure Hardware dialog.

2. In the Configure Hardware dialog, click Configure Acquisition.

3. In the Configure Acquisition dialog, ensure that a driver is listed in the Installed Drivers
column.
If a driver is not listed in the Installed Drivers column, or if more than one driver is listed,
contact Molecular Devices support to determine which driver is required for your
system.

4. In the Installed Drivers column, select the appropriate driver.

5. Click Configure to query the camera.

6. In the camera driver dialog, ensure that the camera is available in channel 1.
This confirms that the camera is responsive.

7. Click OK to close the camera driver dialog.

8. Click OK to close the Configure Acquisition dialog.

9. Click OK to close the Configure Hardware dialog.

10. Click OK to close theMeta Imaging Series Administrator.
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11. Verify and back up settings in theMetaXpress Software. See Verifying and Backing Up
Settings in theMetaXpress Software on page 33.

Verifying and Backing Up Settings in the MetaXpress Software
After confirming hardware settings in theMeta Imaging Series Administrator Software, check
the settings in theMetaXpress Software as described in the following procedures:

Verifying Magnification Settings on page 34

Verifying Calibration Settings on page 34

Verifying the Laser Autofocus Sensor on page 36

Verifying the Plate Reference Point (A1 Center) on page 38

Verifying Plate Types on page 39

Confirming Laser Autofocus Settings for Plate Files on page 41

Verifying Shading Correction Files-Legacy on page 42

During the verification process, Molecular Devices recommends that you backup these
settings as described in the procedures. This lets you restore the settings in case they are
lost.

Tip: While using theMetaXpress Software, you can view the software help to get
more information about an active dialog by pressing F1 on your keyboard.
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Verifying Magnification Settings

You need to confirm magnification settings for the objectives before using your system.
Complete the following procedure to verify themagnification settings in theMetaXpress
Software:

1. Open theMetaXpress Software and log in to the database.

2. Click Devices > Configure Magnification.
In the simplified menu structure, click Control > Devices > Configure Magnification.

3. In the Configure Magnification dialog, in the Setting section, verify that there is an
ImageXpress Micro Objective setting and that the check box is selected.

Figure 3-9: The Configure Magnification dialog

4. Confirm that theDefined Settings field contains a setting for each objective on your
system.

5. Click Backup.

6. In the Backup All Magnification Settings dialog, select a name and location for the
backup and then click Save.
Settings can be restored by clicking Restore and choosing the saved file.

7. Click Close.

Verifying Calibration Settings

Complete the following procedure to verify and back up the calibration settings in the
MetaXpress Software:

1. Open theMetaXpress Software and log in to the database.

2. ClickMeasure > Calibrate Distances.
In the simplified menu structure, clickMeasure > Distances > Calibrate Distances.
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3. In the Calibrate Distances dialog, confirm that there are calibration settings in the dialog
that match the objective settings from the Configure Magnification dialog.

Figure 3-10: The Calibrate Distances dialog

4. Make sure the appropriatemagnification setting is selected for each calibration.

Note: Use the same calibration setting for both X and Y.

The following estimated values can be used for ImageXpress Nano System calibration
settings:

Note: For more information on creating calibration settings, with the Calibration
Distances dialog open, press F1 to view theMetaXpress Software application help.
To measure pixel sizes more accurately, in the IXM Taskbar, click System
Maintenance and then clickMeasure Pixel Sizes.
If IXM Taskbar is not installed, contact Technical Support.

Objective Magnification Estimated Calibration

2x 3.317 μm/pixel

4x 1.659 μm/pixel

10x 0.663 μm/pixel

20x 0.332 μm/pixel

40x 0.166 μm/pixel

60x 0.111 μm/pixel

Table 3-2: Estimated Calibration Settings

5. Click Save to File.

6. In the Save Spatial Calibrations dialog, select a name and location for the backup and
then click Save.
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7. In the Calibrate Distances dialog, click Close.

Verifying the Laser Autofocus Sensor

This procedure uses a bead plate to test that the laser autofocus (LAF) sensor is enabled and
functional.
To verify that the Laser Autofocus sensor is responding in theMetaXpress Software:

1. Open theMetaXpress Software and log in to the database.

2. Click Screening > Plate Acquisition Setup.
In the simplified menu structure, click Screening > Acquisition Setup.

3. In the Plate Acquisition Setup dialog, click the Configure tab.

4. In the Configure tab, click the Acquisition tab.

5. Select the Enable laser-based focusing check box.

6. Click theObjective and Camera tab.

7. From theMagnification list, select 10x.

8. Click the Plate tab.

9. From the Plate name list, select Bead Plate IXM-4.

10. Click Eject Plate.

11. Load the Tetra Speck bead plate and then click Load Plate.

12. On the image of the plate, right-click well A1 to move the stage to that well.

13. In the Configure tab, click the Autofocus tab.

14. In the Autofocus tab, click Configure Laser Settings.
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15. In the Configure Laser Autofocus Settings dialog, click Preview Pass.
The Preview Pass window is displayed with a graph of focus intensities compared to the
Z-position. You want to see graphs of sharp peaks in red and green.

Figure 3-11: The Preview Pass window

16. In the Preview Pass window, ensure that there is at least one peak.

If the Preview Pass window shows at least one peak, the Laser Auto Focus Sensor is
enabled and functional.

If the Preview Pass window does not show any peaks, ensure that the plate is
properly seated. Then, in the Configure Laser Autofocus Settings dialog in the
Preview Pass section, select Exposure > Override exposure, increase the value, and
click Preview Pass again.

If the Preview Pass window still does not show a peak, click Laser Autofocus Wizard.
Then, in the Plate Acquire LAF Setup Wizard, follow the on-screen instructions. For
more information while using the Laser Autofocus Wizard, you can view the
software help by pressing F1 on your keyboard.

If the Preview Pass window still does not show a peak, contact Molecular Devices
Technical Support and report the issue. See Obtaining Support on page 149.

For more information on the Preview Pass window, see Confirming Laser Autofocus
Settings for Plate Files on page 41.

17. Close the Preview Pass window.

18. In the Configure Laser Autofocus Settings dialog, click Close.

19. In the Plate Acquisition Setup dialog, click Eject Plate.

20. Remove the Tetra Speck bead plate and then click Load Plate.

21. Click Close.
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Verifying the Plate Reference Point (A1 Center)

Note: To complete this procedure, you need themetal slide holder plate that ships
with the .

Complete the following procedure to ensure that the plate reference point (A1 center) is
properly set in theMetaXpress Software:

1. Open theMetaXpress Software and log in to the database.

2. Click Screening > Plate Acquisition Setup.
In the simplified menu structure, click Screening > Acquisition Setup.

3. In the Plate Acquisition Setup dialog, click the Configure tab.

4. In the Configure tab, click theObjective and Camera tab.

5. From theMagnification list, select the lowest power objective. 10x is the highest that
should be used.

6. In the Camera Binning field, type or select 1.

7. Click the Plate tab.

8. From the Plate name list, select 96 Wells (8x12).

9. Click the Sites to Visit tab.

10. Under Site Options, select Single site.

11. Under the Acquisition > Wavelengths tab, click theW1 tab.

12. From the Illumination setting list tab, select FITC.

13. In the Exposure field, type or select 100milliseconds (ms).

14. Click the Screening > Plate Acquisition and Control.

15. In the Plate Acquisition and Control dialog, from theWavelength list, selectW1 - FITC.

Figure 3-12: The Plate Acquisition and Control dialog

16. In the Step Size field, type 250.
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17. Click Eject Plate to open the top door.

18. Load themetal slide holder plate, and ensure the notch in the plate is in the A1 position
on the stage. There is an integrated pinhole at the A1well position.

Figure 3-13: Loaded metal slide holder plate with integrated A1 well pinhole

19. Click Load Plate to close the top door.

20. Click Go To A1 to move the stage to the A1 position.

21. Click Start Live to open a live image window.

22. If you are using a 4x objective, click the Z control arrows to step the Z-motor (reducing
the step size as you get closer to focus if needed) until the A1 pinhole comes into focus,
and then verify that the hole is visually centered in the field of view.
If the A1 pinhole is not centered, or if you cannot find the hole, contact Molecular
Devices Technical Support. See Obtaining Support on page 149.

23. Click F2: Stop to stop the live image.

24. Click Eject Plate.

25. Remove themetal slide holder plate and then click Load Plate.

26. Click Close.

27. In the Plate Acquisition Setup dialog, click Close.

Verifying Plate Types

Complete the following procedure to ensure that the preconfigured plate type files included
with theMetaXpress Software are available from the Plate Acquisition Setup dialog:

1. Open theMetaXpress Software and log in to the database.

2. Click Screening > Plate Acquisition Setup.
In the simplified menu structure, click Screening > Acquisition Setup.

3. In the Plate Acquisition Setup dialog, click the Configure tab.

4. In the Configure tab, click the Plates tab.
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5. Click the Plate name drop-down list to view the available plate types.

Figure 3-14: Available plate types

If there are several custom plate types available in the list, then you are finished with
this procedure.

If only 96 Wells (8x12), 384 Wells (16x24), and Custom are listed, then continue
with this procedure to load the preconfigured plate type files.

6. Insert theMetaXpress Software Suite installation USB flash drive into the computer.

7. When theMetaXpress Software installation window appears, click Explore Installation
Folders/Files.

8. In Windows Explorer, open the Plates folder to view the preconfigured plate type files
(.plt).

9. Select the plate type files that you need to be available in theMetaXpress Software.

To select adjacent files, click the first file and then hold down the SHIFT key and click
the last file.

To select non-adjacent files, hold down the CTRL key and click the files.

10. Place a copy of the selected files in the Plates folder in your MetaXpress installation
folder.
The default installation path is C:\MX6\Plates.
These files will then appear in the Plate name drop-down list.

Note: The plate files are read-only after they are copied off the flash drive. You
must turn off the read-only attribute of these files before you can modify them in
theMetaXpress Software.

11. In the Plates folder in your MetaXpress installation folder, select all the copied files.

12. Right click the selected files and click Properties.

13. In the Properties dialog, in theGeneral tab, clear the Read-only check box.

14. Click OK.
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Confirming Laser Autofocus Settings for Plate Files

Just before each site is acquired during plate acquisition, the laser autofocus system
automatically moves the vertical (Z-axis) position of the objective to a point where the
bottom of the well is in focus.
Before using a plate file, confirm that the laser autofocus settings are optimized for the plate.
To confirm the laser autofocus settings:

1. Prepare the plate that you are going to test by putting water or buffer similar to the
buffer you will be using for real experiments in several of the wells.

2. Open theMetaXpress Software and log in to the database.

3. Click Screening > Plate Acquisition Setup.
In the simplified menu structure, click Screening > Acquisition Setup.

4. In the Plate Acquisition Setup dialog, click Eject Plate.

5. Place the test plate in position and then click Load Plate.

6. In the Plate Acquisition Setup dialog, click the Configure tab.

7. In the Configure tab, click the Plates tab.

8. From the Plate name drop-down list, select the plate type you are testing.

9. In theObjective and Camera tab, select a magnification.

10. In the Acquisition tab, verify that Enable laser-based focusing is selected.

11. Using the navigation tools at the top of the Plate Acquisition Setup dialog, move to an
appropriate well and site.

12. In the Autofocus tab, click Configure Laser Settings.

Note: If the Configure Laser Settings button is highlighted in red, the autofocus
was not configured for this plate and objective configuration. To correct this, run
the Laser Autofocus Wizard.

13. Click Find Sample, and verify that the focus status reports Focus Found and that the
resulting focus position is appropriate for the plate.

Note: If the focus status reports Focus Not Found, or if the Fine z-position result
is wrong, optimize the laser autofocus settings using the Laser Autofocus Wizard

14. When finished, close the focus status report dialog and the Configure Laser Autofocus
Settings dialog.

Note: The Laser Autofocus Wizard calculates measurements as accurately as
possible. Somemanual verification and adjustment of the settings might be necessary
to optimize the results.
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Note: If you are using an objective with a correction collar, ensure that the correction
collar is set appropriately for the plate you are using. For information on configuring
the correction collar, see Adjusting the Spherical-Aberration Correction Collar on
ELWD Objectives on page 143.

Verifying Shading Correction Files-Legacy

Note: This procedure is required if Legacy Correction is selected for one or more
wavelengths in an acquisition protocol.

If Legacy Correction is selected as the Shading Correctionmethod for an acquisition
wavelength, then shading correction image files are needed for eachMagnification and
Illumination setting, and these images must be generated whenever an objective or filter
set is replaced or added to the system .

Note: For information about creating Legacy Correction shading correction image
files, see Updating Shading Correction Settings-Legacy on page 145.

To verify that the shading correction images are available for plate acquisitions using the
Legacy Correction setting, do the following:

1. Open theMetaXpress Software and log in to the database.

2. Click Screening > Plate Acquisition Setup.
In the simplified menu structure, click Screening > Acquisition Setup.

3. In the Plate Acquisition Setup dialog, click the Configure tab.

4. In the Configure tab, click the Acquisition tab.

5. During your initial on-site system installation, the shading correction image files are
configured to be found in the C:\Shading Images folder.
To change the default image location, click Directory for Stored Correction Images, and
then in the Browse for Folder dialog, select the new location.
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Chapter 4: Preparing For Acquisition

This section provides general guidelines to consider before acquiring experiment plate data.
These guidelines help ensure that the images you acquire are the best possible quality.
Review these guidelines before you define your experiment settings.
The following are some criteria to consider to get the best possible fluorescence image
quality:

Assay Design on page 43

Plate Selection on page 44

Sample Preparation on page 46

Instrument Maintenance on page 47

Assay Design

Evaluating your Experiment Requirements
When designing a high-content screening assay, it is important to consider the downstream
image analysis steps. Despite the image enhancement tools and options available to you in
theMetaXpress Software, it is difficult to analyze a poor quality image. Starting with quality
images helps ensure that your image data is moremeaningful, and yields more information.
As with any biological assays, the assay conditions need to be correctly evaluated to obtain a
meaningful result. Include both negative and positive controls in your sample preparation so
you can judge the validity of your assay. Run a small-scale version of the assay for
optimization of the assay conditions before running a large-scale screen.

Selection of Different Fluorochromes

Typical high-content assays include one or more fluorochromes, including fluorescent
proteins, antibody-based stains, and chemical-based stains. In general, Molecular Devices
recommends including a nuclear stain such as Hoechst or DAPI to help with identification of
the cells during image analysis. If the assay involves movement of a protein of interest to or
from a particular cellular compartment or organelle, it can also be helpful to include a probe
specific to that cellular compartment or organelle. If you are planning on using a standard
MetaXpress Softwaremodule to analyze your data, review the requirements of that module.
Individual fluorochromes have unique characteristics that help determine their best use. Use
probes that provide bright, specific staining and that have excitation and emission spectra
suitable for the filter sets in your ImageXpress System. For experiments using multiple stains,
select fluorophores that have sufficient spectral separation. Some fluorochromes provide
brighter intensities and require a shorter exposure time, while others do not bleach as
quickly and allow a longer exposure time. There also might be toxicity issues with some cell
types or bleed-through issues between pairs of fluorochromes. Consider these factors when
choosing a fluorochrome.

4
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If your ImageXpress System has the Transmitted Light option, then it might be possible to
identify cells using Transmitted Light images instead of fluorescence.

Cell-Based Assays

Themost important consideration when selecting cells for a high-content assay is whether
they are compatible with the biology being studied. The assay should give a robust response
with clear distinction between positive and negative phenotypes. In addition, it is important
to select a source of cells where it is possible to obtain consistent results from batch to
batch, whether they are primary cells or cell lines, and whether they are transfected or not.

Plates or Slides

Molecular Devices recommends the use ofmulti-well plates for high-content screening. The
well layout is consistent from one plate to another, plates are easier to handle during sample
preparation and imaging, and it is easier to scale up for a larger screen. However, some
assays, such as imaging of tissue sections, require the use of slides. A slide holder is provided
in the accessory kit, and there are software tools available to streamline a typical
slide-imaging workflow.

Plate Selection
The specific type of plate used can have a significant impact on image quality. Molecular
Devices recommends that you assess various plates for their compatibility with your assay,
and that you use plates of only one brand from a single manufacturer. Mixing various plate
types from different manufacturers could introduce unknown variables and contribute to
creating flawed data.
In addition to availability and cost, consider the following factors when selecting plates for
your assay:

Plate Format, see page 45

PlateMaterial, see page 45

Fluorescence Background, see page 45

Bottom Thickness, see page 45

Plate Flatness or Reproducibility of the Z-Pattern, see page 45

Plate Skirt

Batch-to-Batch Consistency, see page 46

Robot Compatibility



Chapter 4: Preparing For Acquisition

5058342 B 45

Plate Format

Determine if the plate format is compatible with your assay.

Howmany wells are in each plate?

Is the well size compatible with the assay, and will the plates allow for the desired
throughput?

Do you have the equipment needed for pipetting into and washing the plates?

Plate Material

The composition of thematerial of the bottom of themicroplate needs to be of optical
quality, or the images can be degraded. For fluorescence imaging, microplates with black well
sides and a single-piece clear bottom usually work the best. Plastic-bottomed plates are
generally more uneven and distort light more than glass-bottomed plates. When using high
magnifications, there are significant differences in clarity between standard plastic plates,
optically clear plastic plates, and glass bottom plates.
Verify that your cells are compatible with the platematerial. There are some cells that adhere
to and perform better on plastic. Given the wrong surface, some cells fail to bind and behave
unusually, such as rounding up, or migrating to the edges of the well. In some cases, coating
the plates or using pre-coated plates can be beneficial.

Fluorescence Background

There is a large difference in auto-fluorescence between glass and plastic. Also, there can be
up to a 5X difference in auto-fluorescence among plates from different manufacturers.

Bottom Thickness

The thickness of the plate bottom should be compared with the working distance of the
objective lens to be used to ensure that it is compatible. In general, objectives with higher
numerical aperture (NA) tend to require thin-bottomed plates. The extra-long working
distance (ELWD) objectives are compatible with a larger range of plate thicknesses but, tend
to have lower NA. Plates with a bottom thickness comparable to a standard coverslip
(0.17 mm)work well with most of the objectives.

Note: Plates with ultra-thin bottoms or very thick bottoms can bemore uneven,
possibly causing focusing issues. For best results, Molecular Devices recommends
using imaging-quality plates with 0.15 mm–0.7 mm bottom thickness.

Plate Flatness or Reproducibility of the Z-Pattern

A flat plate is faster to scan than an uneven plate because the autofocus search range can be
made smaller. The reproducibility of a plate allows you to set tighter focus ranges specifically
for that plate type. This reduces the amount of focusing needed and speeds up acquisition.
Themajor component in plate flatness is the variation from a well to a neighboring well.
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Batch-to-Batch Consistency

Some platemanufacturers aremore consistent in producing plates than others. If
parameters such as the plate-bottom thickness vary from batch to batch, the plate settings
must be optimized for each batch.

Sample Preparation
There aremany variables involved in sample preparation. It is best to test these variables as
appropriate during the assay optimization phase, before preparing a large number of plates
for screening.
The following are some specific items to consider for imaging assays:

Cell Density, see page 46

Fixation and Staining Conditions, see page 46

Final Buffer or Media, see page 46

Plate Handling and Storage, see page 47

Cell Density

Cell density can affect the performance of the cells as well as downstream image analysis. If
the cells are very sparse, you might need to acquire many sites in order to have a sufficient
population for statistical analyses. If the cells are very dense, it might be difficult to identify
individual cells accurately during cell segmentation.

Fixation and Staining Conditions

Fixation, permeabilization, and washing steps that are too harsh or aggressive can damage
the cells and affect image quality. Generally, fixation in freshly-prepared, pre-heated, 4%
methanol-free formaldehyde works well for many cell types. When optimizing the assay, it is
also helpful to test a range of antibody and stain concentrations to determine the best
conditions for your cells.

Final Buffer or Media

To reduce background in the fluorescent images, make sure that the buffer or media that the
cells are left in is free of fluorescent components such as Phenol Red. This is most important
for widefield assays. Solutions with a high percentage of glycerol, such as mounting media,
are not recommended. Glycerol can interfere with the laser autofocus, and the high viscosity
can cause pipetting difficulties, resulting in air bubbles. Finally, a low volume of liquid can
also interfere with the laser autofocus and with transmitted light images. In general, make
sure that wells are at least halfway full. Avoid letting cells dry out while the plate sits for an
extended time before imaging.
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Plate Handling and Storage

Since the laser measures the reflection from the bottom of the plate or from within the
sample, dust particles, dirt, fingerprints, and scratches interfere with the reflection and affect
the performance of the autofocus. To improve the autofocus, clean the bottom of the plate
using lens tissue and an optical cleaning solution. Plates should be stored in the dark, and
generally, fixed plates should be stored at 4⁰C. An opaque plate seal can be helpful. Avoid
condensation of air humidity on the bottom of plates. Before imaging, allow chill-stored
plates to be brought back to room temperature.

Instrument Maintenance
For best performance, your should have regular preventivemaintenance (PM) services. In
between PM services, the system administrator can clean dust off the optics as needed (see
Maintenance on page 141). Wear gloves when handling any optical components to avoid
contaminating them with dirt or skin oils.
The basic design of the light source and light path within the imager help ensure that the
light reaching your sample is the best possible quality. If you find that the light quality has
become degraded, contact your system administrator or your Molecular Devices
representative to correct the problem.
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Chapter 5: Configuring Plate Acquisition Options

Before configuring an experiment, it is important to become familiar with the configuration
tools available in theMetaXpress® Software. The foundation of theMetaXpress Software is
theMetaMorph®Microscopy Automation and Image Analysis Software. TheMetaMorph
Software contains numerous dialogs for image acquisition, processing, and acquisition. The
MetaXpress Software adds database integration and tools for controlling the
ImageXpress Nano System and for acquiring and analyzing microplates.
This section explains the Plate Acquisition Setup dialog that is used to configure and run a
screening experiment.

Note: Beginning with Version 6.0 of theMetaXpress Software, the well and site
navigation functions that were previously available only from the Plate Acquisition
and Control dialog are now also available from the Plate Acquisition Setup dialog.
You can continue to use the Plate Acquisition and Control dialog, but for efficiency
and convenience, you can just use the single Plate Acquisition Setup dialog.

Accessing the Plate Acquisition Setup Dialog, see page 50

Plate Acquisition Setup Dialog Layout, see page 51

Plate Acquisition Setup Dialog: Configure Tab, Objective and Camera Tab, see page 55

Plate Acquisition Setup Dialog: Configure Tab, Plate Tab, see page 56

Plate Acquisition Setup Dialog: Configure Tab, Sites to Visit Tab, see page 61

Plate Acquisition Setup Dialog: Configure Tab, Acquisition Tab, see page 75

Plate Acquisition Setup Dialog: Configure Tab, Display Tab, see page 107

Viewing the Summary Panel, see page 111

Saving a Plate Acquisition Protocol, see page 112

5
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Accessing the Plate Acquisition Setup Dialog
TheMetaXpress Softwaremain menu includes the Screeningmenu, which is used specifically
in theMetaXpress Software for protocol configuration and image acquisition. The Screening
menu provides access to all plate configuration dialogs and acquisition-specific dialogs,
including the Plate Acquisition Setup dialog. Figure 5-1 and Figure 5-2 show the options that
are available from the Screeningmenu.

Figure 5-1: Default Screening Menu

Figure 5-2: Simplified Screening Menu
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Plate Acquisition Setup Dialog Layout
The Plate Acquisition Setup dialog provides three primary functions.

Plate Navigation that provides manual control of some of themovable physical
components of the ImageXpress Nano System.

Configuration control on the Configure tab for setting up plate acquisition protocols.

Acquisition Control on the Run tab for doing a plate acquisition according to a selected
protocol.

Figure 5-3: Plate Acquisition Setup Dialog

The following functionality is available in the Plate Acquisition Setup dialog:

Protocol provides a list of the eight most recently used plate acquisition protocols.

Load Protocol button opens the Load Plate Acquisition Protocol dialog in which you
select a protocol for plate acquisition.
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Eject Plate/Load Plate button switches between the following two options

Eject Plate opens the top door for loading or removing a plate.

Load Plate closes the top door so that the plate can be acquired.

Plate map (upper left) is a graphical representation of the type of plate for which you are
configuring the wells. The graphic is interactive to providemanual control for moving a
stage to a specific well. By default, when the Plate Acquisition Setup dialog opens the
first time, and before any protocols are configured and loaded, all of the wells in the
platemap are selected for data acquisition. Selected wells in the platemap are displayed
in bright green.
To disable any data acquisition selection, click on the specific well in the graphic, click and
drag over a section of wells, or click the row or column header. Disabled wells in the plate
map are displayed in gray.
To enable or disable all wells, click the upper left corner triangle.

Figure 5-4: Plate Acquisition Setup Dialog, Plate map

Site map (upper right) is a graphical representation of the number of sites in each well
and the position of the sites that are to be acquired for each well. The graphic is
interactive to providemanual control for some of themovable physical components of
the . You use this interactive graphic to configure the sites that are to be acquired.
Selected sites in themap are highlighted in bright green. Disabled sites in themap are
highlighted in gray.

Figure 5-5: Plate Acquisition Setup dialog, Site map

Active Wavelength field displays the currently selected acquisition wavelength.



Chapter 5: Configuring Plate Acquisition Options

5058342 B 53

Active Wavelength tools provide shortcuts to various functions that can be done for the
currently selected acquisition wavelength.

Figure 5-6: Active Wavelength tools

Note: There are a few use cases when configuring a plate acquisition protocol with
the Active Wavelength is applicable, and these use cases are discussed where
appropriate in this section. These tools, however, are primarily used when
acquiring plate data.

Configure tab provides the necessary options for configuring a plate acquisition
protocol. The Configure tab is organized in a “top-to-bottom” tab structure that runs
down the left side of the dialog and is designed to guide you through the process of
setting up your protocol configuration in a logical order. Each tab is dedicated to a
specific type of function or setting. The tabs are dynamically updated according to the
options that you have selected and the number of wavelengths that you are acquiring.
See

Plate Acquisition Setup Dialog: Configure Tab, Objective and Camera Tab on page 55

Plate Acquisition Setup Dialog: Configure Tab, Plate Tab on page 56

Plate Acquisition Setup Dialog: Configure Tab, Sites to Visit Tab on page 61

Plate Acquisition Setup Dialog: Configure Tab, Acquisition Tab on page 75

Plate Acquisition Setup Dialog: Configure Tab, Display Tab on page 107

Run tab includes essential options for acquiring a plate using a selected protocol.

Save Protocol opens the Save Acquisition Protocol dialog in which you can save the
current plate acquisition settings as a protocol. See Saving a Plate Acquisition Protocol
on page 112.

Figure 5-7: Save Acquisition Protocol dialog
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Summary button opens the Summary panel that displays a summary of all the current
acquisition settings. See Viewing the Summary Panel on page 111.

Note: When you are configuring a protocol on the Plate Acquisition Setup dialog,
red or yellowwarning icons might be displayed. A yellow icon indicates that an
optional field is not filled in or could indicate another minor error. A red icon
indicates that a required field is either not filled in or contains invalid data that
must be changed. Figure 5-8 shows the dialog with several warning icons.

Figure 5-8: Plate Acquisition Setup Dialog with Warning Icons
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Plate Acquisition Setup Dialog: Configure Tab, Objective and Camera Tab
You set the objectivemagnification, the camera binning, the gain for a protocol in the
Objective and Camera tab. Based on these settings, you can improve either the image
acquisition speed or the image quality.

Figure 5-9: Plate Acquisition Setup dialog: Configure tab, Objective and Camera tab

Option Description

Magnification Selects the magnification setting for the protocol. Magnification settings assign X
and Y offset values (parcentricity) and a Z offset (parfocality) to a specific objective.
When you select a specific objective, the objective is physically moved to the
acquisition position.
Note: The available magnifications are defined with the Configure Magnification
dialog. See Verifying Magnification Settings on page 34. You must assign a
calibration to each magnification setting. See Verifying Calibration Settings on page
34.

Camera binning Specifies the binning value that is to be applied to the camera. Binning combines
the output of adjacent pixels in square multiples. For example, a camera binning
value of 1 is only one pixel, a binning value of 2 combines 2x2 or four pixels in a
square, a binning value of 3 combines 3x3 or nine pixels in a square, and so on.
This reduces the image file size and resolution, and increases signal-to-noise ratio.
Note: If sufficient light is available, lower camera binning increases the image
resolution, whereas higher binning increases the signal-to-noise ratio for a given
exposure time. Higher binning also improves the speed of the acquisition for a
given target signal per bin.

Table 5-1: Plate Acquisition Setup dialog: Configure tab, Objective and Camera tab
configuration options
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Option Description

Camera gain Specifies the amplification that is to be applied to the camera output.

Table 5-1: Plate Acquisition Setup dialog: Configure tab, Objective and Camera tab
configuration options (continued)

Configuring Objective and Camera Options

Tip: As you are configuring an acquisition protocol, you can open the Summary panel
and leave it open to view the current values for all of the protocol settings.

1. Click theObjective and Camera tab.

2. Select theMagnification setting for the protocol to move the selected objective into
position.

3. Specify the Camera binning value that is to be applied to the camera.

Note: The resulting pixel size (image calibration) is updated based on the current
magnification and binning settings.

4. If applicable, select the amount of gain.

5. When you are finished configuring the acquisition protocol, then continue to Saving a
Plate Acquisition Protocol on page 112. Otherwise, continue with the next steps to
further optimize your protocol settings. See:

Plate Acquisition Setup Dialog: Configure Tab, Plate Tab on page 56.

Plate Acquisition Setup Dialog: Configure Tab, Sites to Visit Tab on page 61.

Plate Acquisition Setup Dialog: Configure Tab, Acquisition Tab on page 75.

Plate Acquisition Setup Dialog: Configure Tab, Display Tab on page 107.

Plate Acquisition Setup Dialog: Configure Tab, Plate Tab
You configure the required plate dimensions on the Plate tab to accurately control the X, Y,
and Z movements of the ImageXpress Nano System . Defining accurate plate dimensions
prevents the imager from making potentially hazardous movements. Your defined plate
dimensions also ensure that the laser-based autofocusing is as accurate as possible.
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Figure 5-10: Plate Acquisition Setup dialog: Configure tab, Plate tab

Note: TheMetaXpress Software installation flash drive comes with a variety of
common plate types already configured. From theMetaXpress Software flash drive,
find the Plates folder for plate files. Also see: Verifying Plate Types on page 39.

Option Description

Plate name Specifies the plate type that you are using for the protocol. You can select an
existing configuration, or you can create a new custom plate configuration. The tab
fields are automatically populated with values according to the plate type that you
select. If your plate type is not available on the Plate name list, then you must
manually type the manufacturer’s plate specifications for these values.
Note: The manufacturer generally cannot provide values for the Plate Bottom
settings, including Optical thickness, which is not the same as physical thickness,
and the Bottom variation. You must run the Laser Autofocus Wizard to measure
these values on the instrument to ensure proper focusing. See Considering Plate
Dimensions on page 59.

Save
Configuration

Opens the Save Configuration dialog that you use to name and save a new custom
plate configuration based on the currently displayed plate type values.

Number of
rows

Indicates the number of rows for the selected plate type.

Number of
columns

Indicates the number of columns for the selected plate type.

Well shape Indicates the shape of the well on the plate, either Circle or Square.

Table 5-2: Plate Settings
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Option Description

Well diameter Specifies the diameter of the well in µm.
Note: The wells for many plate types have a slight conical shape. If you are creating
a new custom plate configuration, then you must provide the diameter of the
bottom of the well, not the top.

Column
spacing

Specifies the spacing in µm between each well on the X axis.
Note: Generally, this value should be the same for both the X and Y axis; however, if
you are creating a new custom plate configuration, you can specify different values
if needed.

Plate length Specifies the plate length in mm. The ANSI standard is 127.8 mm.

Column offset Specifies the distance in µm between the center of well A01 and the left edge of
the plate.

Row Spacing Specifies the spacing in µm between each well on the Y axis.
Note: Generally, this value should be the same for both the X and Y axis. However, if
you are creating a new custom plate configuration, you can specify different values
if needed.

Plate width Specifies the Plate width in mm. The ANSI standard is 85.5 mm.

Row offset Specifies the distance in µm between the center of well A01 and the top edge of
the plate.

Well depth Specifies the well depth in µm.
Note: The correctWell depth value is required for autofocusing.

Plate height Specifies the plate height in mm.
Note: The correct Plate height value is required for autofocusing.

Edit Plate
Bottom
Settings

Opens the Configure Plate Bottom Settings dialog that you use to adjust plate
bottom settings.
CAUTION! This dialog is intended primarily for informational and diagnostic
purposes, and only advanced users should use this feature to adjust plate bottom
settings. If you adjust plate bottom settings incorrectly, you might damage the
objective or plate. Molecular Devices strongly recommends that you use the Laser
Autofocus Wizard to calculate the plate bottom measurements instead of editing
them here.

Laser
Autofocus
Wizard

Opens the Laser Autofocus Wizard, which guides you step by step through the
process of automatically calculating plate bottom dimensions and the focus laser
exposure times that are required for each objective with your selected plate type.

Table 5-2: Plate Settings (continued)



Chapter 5: Configuring Plate Acquisition Options

5058342 B 59

Considering Plate Dimensions

Even if you select an existing plate type configuration, Molecular Devices recommends that
you use the Laser Autofocus Wizard to verify the accuracy of the Bottom thickness and the
four different variation measurements for your plates, where:

Bottom thickness is a value in µm that is the average optical thickness for the well
bottom.

The four different measurements include the following:

Bottom thickness max variation

Adjacent well max variation

Intra-well max variation

Platemax variation

Note: All plate bottom thickness values (also known as reduced thickness
measurements) are optical thickness as measured using the objective. These values
are not equivalent to the physical thickness measurements that the plate
manufacturer provides. The optical thickness is calculated by the software by dividing
the physical thickness of the plate bottom by the refractive index of thematerial of
which it is composed.

Although platemanufacturers generally provide reliable plate and well dimensions, you must
calculate the plate bottom measurements, such as average thickness and maximum
variation in thickness of the entire plate. These parameters are critical and can vary from lot
to lot. Also, platemanufacturers can change plate parameters without changing plate
names. The Laser Autofocus Wizardwalks you through the steps to automatically calculate
plate bottom dimensions as well as the exposure times that are required for each objective.

Note: The Laser Autofocus Wizard calculates measurements as accurately as
possible. Somemanual verification and adjustment of the settings might be necessary
to optimize the results, particularly for thin-bottom plates. For detailed information
about the settings that the wizard calculates, see the “Configure Laser Autofocus
Settings Dialog Options” topic in theMetaXpress Software help. With the Laser
Autofocus wizard open, press F1 to access the help. If you need more assistance,
contact Technical Support. See Obtaining Support on page 149.

CAUTION! Do not use the Laser Autofocus Wizard for slides because this feature is
not compatible with slides. If you need assistance imaging slides, contact Technical
Support. See Obtaining Support on page 149.



ImageXpress Nano System with MetaXpress Software User Guide

60 5058342 B

Configuring the Dimensions for a new Custom Plate Configuration

If your custom plate is 96-well or 384-well format, then you can select the appropriate
template, and modify any values as needed. If your custom plate is any other size, then you
must specify all the values for the plate.

Tip: As you are configuring an acquisition protocol, you can open the Summary panel
and leave it open to view the current values for all of the protocol settings.

1. Choose the appropriate size for your custom plate.

2. Click Save Configuration.

3. In the Plate Acquisition - Save Configuration dialog, type the name for your custom
plate configuration, and then click Save.

4. In theWell shape field, select the well shape for the plate.

5. Complete the remaining configuration fields as required. See Table 5-2: Plate Settings on
page 57.

CAUTION! You must enter theWell depth and Plate height values and all other
plate dimensions correctly before you run the Laser Autofocus Wizard to prevent
the wizard from failing.

6. Click Laser Autofocus Wizard and follow the steps that the wizard provides to calculate
plate bottom measurements.

7. If required, edit theWell depth field and the Plate height field values.

8. Click Save Configuration.

9. Click Plate Acquisition - Save Configuration > Save, and then to overwrite the existing
custom plate type, click Yes.

Note: If needed, adjust any objectives with correction collars to match the plate
bottom thickness. See Adjusting the Spherical-Aberration Correction Collar on
ELWD Objectives on page 143.

10. If you are done configuring your protocol, continue to Saving a Plate Acquisition
Protocol on page 112. Otherwise, continue to any other configuration as needed. See:

Plate Acquisition Setup Dialog: Configure Tab, Objective and Camera Tab on page 55.

Plate Acquisition Setup Dialog: Configure Tab, Sites to Visit Tab on page 61.

Plate Acquisition Setup Dialog: Configure Tab, Acquisition Tab on page 75.

Plate Acquisition Setup Dialog: Configure Tab, Display Tab on page 107.
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Plate Acquisition Setup Dialog: Configure Tab, Sites to Visit Tab
You configure the number of sites that are to be acquired for each well in a plate acquisition
protocol on the Sites to Visit tab. You can acquire a single site per well, or multiple sites per
well. The number of sites that you can acquire in a well depends on the size of the well, the
objectivemagnification, the distribution of samplematerial in the well, the type of plate, and
the fluid content of the well.
The dialog tab is dynamically updated with the appropriate configuration options based on
the site option that you select. The site map, which is a graphical representation of the sites
that you are configuring, is dynamically updated based on the configuration options that
you select and the values that you specify for these options.

Note: You use the platemap and site map that are at the top of the Plate Acquisition
Setup dialog to select and move to the wells and sites that are to be analyzed in a
plate acquisition protocol.

Also See:

Acquiring a Single Site in Each Well on page 61

Acquiring a Fixed Number of Sites in Each Well on page 63

Configuring Adaptive Acquisition for Well Sites on page 66

Configuring a Multi-Well Acquisition on page 73

Acquiring a Single Site in Each Well

To acquire a single site in each well, use the following procedure.

Tip: To acquire a single off-center site, you should select Fixed number of sites,
configure the site layout, and then deselect the unwanted sites. See Acquiring a Fixed
Number of Sites in Each Well on page 63.
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Figure 5-11: Plate Acquisition Setup dialog: Configure tab, Sites to Visit tab, Single site
option selected

Tip: As you are configuring an acquisition protocol, you can open the Summary panel
and leave it open to view the current values for all of the protocol settings.

1. Open the Sites to Visit tab.

2. Select Single Site.

3. Optionally, to specify a percentage of the field of view the camera will acquire, select
Custom Field of View (%), and then type the X (width) value and Y (height) value.

Note: The full field of view for the camera is 100 percent (100% in the X field and
100% in the Y field). So, for example, if the full field of viewwidth is 1000 µm, then
to acquire a width of 500 µm, enter 50 in the X field.

Note: The Custom Field of View feature is compatible with full-size shading
correction images when using Legacy Correction.

Tip: This feature is particularly useful for acquiring images from an unevenly
illuminated full field, or for acquiring images that include the area outside the well
boundary.
ForMulti-well acquisitions, use the full field of view, because the Custom Field of
View value severely reduces the amount from each well acquired.
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4. Use the platemap to specify a subset of wells within a plate for data acquisition. All active
wells are green in the platemap. Inactive wells are gray in the platemap.

To turn off a single well, click on a green well graphic. The well turns gray to indicate
that this well will be skipped during data acquisition. To turn it back on, click the well
again. The well turns green again.

To turn off a column of wells, click on the number header. The column of wells turns
gray to indicate that they will all be skipped during data acquisition. To turn them
back on, click the column header again. The wells turn green again.

To turn off a row of wells, click on the letter header. The row of wells turns gray to
indicate that they will all be skipped during data acquisition. To turn them back on,
click the letter header again. The wells turn green again.

To turn off a contiguous group of wells, click and drag the red-outline across the
group of wells for selection. The selection group turns gray. To turn them back on,
click and drag the red-outline across the group of wells for selection again. The wells
turn green again.

To turn off or on all wells in a plate in a single step, click the white triangle in the
upper-left corner of the platemap.

Note: You can preselect the wells for the acquisition as part of the automated
protocol, or you can select the wells at the time that you run the protocol.

5. If you are done configuring your protocol, continue to Saving a Plate Acquisition
Protocol on page 112. Otherwise, continue to any other configuration as needed. See:

Plate Acquisition Setup Dialog: Configure Tab, Objective and Camera Tab on page 55.

Plate Acquisition Setup Dialog: Configure Tab, Plate Tab on page 56.

Plate Acquisition Setup Dialog: Configure Tab, Acquisition Tab on page 75.

Plate Acquisition Setup Dialog: Configure Tab, Display Tab on page 107.

Acquiring a Fixed Number of Sites in Each Well

To acquire a fixed number of sites in each well, use the following procedure.

Tip: As you are configuring an acquisition protocol, you can open the Summary panel
and leave it open to view the current values for all of the protocol settings.
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Figure 5-12: Plate Acquisition Setup dialog: Configure tab, Sites to Visit tab, Fixed
number of sites option selected

1. Open the Sites to Visit tab.

2. Select Fixed number of sites.

3. Optionally, to specify a percentage of the field of view the camera will acquire, select
Custom Field of View (%), and then type the X (width) value and Y (height) value.

Note: The full field of view for the camera is 100 percent (100% in the X field and
100% in the Y field). So, for example, if the full field of viewwidth is 1000 µm, then
to acquire a width of 500 µm, enter 50 in the X field.

Note: The Custom Field of View feature is compatible with full-size shading
correction images when using Legacy Correction.

Tip: This feature is particularly useful for acquiring images from an unevenly
illuminated full field, or for acquiring images that include the area outside the well
boundary.
ForMulti-well acquisitions, use the full field of view, because the Custom Field of
View value severely reduces the amount from each well acquired.

4. In the Columns and Rows fields, specify themaximum number of sites to be visited. For
example, the default values Columns 2 and Rows 2 acquire up to four sites, while
specifying Columns 3 and Rows 3 acquires up to nine sites.
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Note: Themaximum allowable values for these fields are Columns: 45 and Rows:
35.

5. Use the platemap to specify a subset of wells within a plate for data acquisition. All active
wells are green in the platemap. Inactive wells are gray in the platemap.

To turn off a single well, click on a green well graphic. The well turns gray to indicate
that this well will be skipped during data acquisition. To turn it back on, click the well
again. The well turns green again.

To turn off a column of wells, click on the number header. The column of wells turns
gray to indicate that they will all be skipped during data acquisition. To turn them
back on, click the column header again. The wells turn green again.

To turn off a row of wells, click on the letter header. The row of wells turns gray to
indicate that they will all be skipped during data acquisition. To turn them back on,
click the letter header again. The wells turn green again.

To turn off a contiguous group of wells, click and drag the red-outline across the
group of wells for selection. The selection group turns gray. To turn them back on,
click and drag the red-outline across the group of wells for selection again. The wells
turn green again.

To turn off or on all wells in a plate in a single step, click the white triangle in the
upper-left corner of the platemap.

Note: You can preselect the wells for the acquisition as part of the automated
protocol, or you can select the wells at the time that you run the protocol.

6. Use the site map to specify a sub-set of sites within a well for data acquisition.

To turn a site off, click it. The site turns gray, which indicates that data will not be
acquired for the site. To turn the site back on, click the site again. The site turns
bright green again.

To turn off a contiguous group of sites in a single step, click and hold the left mouse
button, and then drag the cursor across the appropriate sites. To turn the sites back
on, click and hold the left mouse button, and then drag the cursor across the sites
again.

Note: The site controls apply to all sites in all wells at the same time. When you
turn on or off sites for a selected well, then all wells in the plate will have data
acquired for the same sites.

Note: You can configure automated data acquisitions for the wells as part of a
protocol. .
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7. Optionally, do one of the following as needed:

To manually adjust the spacing between adjacent sites, where the default value is
zero, or no spacing, enter the X and Y values for the spacing in the Spacing (µm)
fields.

To manually adjust the spacing between adjacent sites so that the sites overlap,
enter negative X and Y values for the spacing in the Spacing (µm) fields.

Note: The camera size limits these values, and therefore, the amount of
overlapping that you can specify.

To automatically adjust the spacing between adjacent sites so that there is zero
spacing between them, click Tile sites. The X and Y spacing values are set to zero.

To automatically adjust the spacing between the adjacent sites to themaximum
allowed value based on the selected plate type, click Fit sites to well. The X and Y
spacing values are updated accordingly.

To automatically overlap the sites by 10%, click Overlap Sites 10%. The X and Y
spacing values are updated to the appropriate negative values based on the selected
plate type.

8. If you are done configuring your protocol, continue to Saving a Plate Acquisition
Protocol on page 112. Otherwise, continue to any other configuration as needed. See:

Plate Acquisition Setup Dialog: Configure Tab, Objective and Camera Tab on page 55.

Plate Acquisition Setup Dialog: Configure Tab, Plate Tab on page 56.

Plate Acquisition Setup Dialog: Configure Tab, Acquisition Tab on page 75.

Plate Acquisition Setup Dialog: Configure Tab, Display Tab on page 107.

Configuring Adaptive Acquisition for Well Sites

The Adaptive acquisition option is a computational algorithm that is designed to analyze
the number of cells on the fly during sample acquisition to increase the chances of collecting
valid data in every well. If this option is selected, then the number of sites that are acquired
per well is based on the number of cells per well.

Note: The Adaptive acquisition option can significantly reduce acquisition time for
multi-wavelength acquisition that requires a minimum number of cells per well or for
samples with differing conditions across the plate.

Tip: As you are configuring an acquisition protocol, you can open the Summary panel
and leave it open to view the current values for all of the protocol settings.
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Figure 5-13: Plate Acquisition Setup dialog: Configure tab, Sites to Visit tab, Adaptive
Acquisition option selected

1. Open the Sites to Visit tab.

2. Select Adaptive Acquisition.

3. Optionally, to specify a percentage of the field of view the camera will acquire, select
Custom Field of View (%), and then type the X (width) value and Y (height) value.

Note: The full field of view for the camera is 100 percent (100% in the X field and
100% in the Y field). So, for example, if the full field of viewwidth is 1000 µm, then
to acquire a width of 500 µm, enter 50 in the X field.

Note: The Custom Field of View feature is compatible with full-size shading
correction images when using Legacy Correction.

Tip: This feature is particularly useful for acquiring images from an unevenly
illuminated full field, or for acquiring images that include the area outside the well
boundary.
ForMulti-well acquisitions, use the full field of view, because the Custom Field of
View value severely reduces the amount from each well acquired.

4. In the Columns and Rows fields, specify themaximum number of sites to be visited. For
example, the default values Columns 2 and Rows 2 acquire up to four sites, while
specifying Columns 3 and Rows 3 acquires up to nine sites.

Note: Columns: 45 and Rows: 35 are themaximum allowable configuration.

5. Use the platemap to specify a subset of wells within a plate for data acquisition. All active
wells are green in the platemap. Inactive wells are gray in the platemap.
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To turn off a single well, click on a green well graphic. The well turns gray to indicate
that this well will be skipped during data acquisition. To turn it back on, click the well
again. The well turns green again.

To turn off a column of wells, click on the number header. The column of wells turns
gray to indicate that they will all be skipped during data acquisition. To turn them
back on, click the column header again. The wells turn green again.

To turn off a row of wells, click on the letter header. The row of wells turns gray to
indicate that they will all be skipped during data acquisition. To turn them back on,
click the letter header again. The wells turn green again.

To turn off a contiguous group of wells, click and drag the red-outline across the
group of wells for selection. The selection group turns gray. To turn them back on,
click and drag the red-outline across the group of wells for selection again. The wells
turn green again.

To turn off or on all wells in a plate in a single step, click the white triangle in the
upper-left corner of the platemap.

Note: You can preselect the wells for the acquisition as part of the automated
protocol, or you can select the wells at the time that you run the protocol.

6. Use the site map to specify a sub-set of sites within a well for data acquisition.

To turn a site off, click it. The site turns gray, which indicates that data will not be
acquired for the site. To turn the site back on, click the site again. The site turns
bright green again.

To turn off a contiguous group of sites in a single step, click and hold the left mouse
button, and then drag the cursor across the appropriate sites. To turn the sites back
on, click and hold the left mouse button, and then drag the cursor across the sites
again.

Note: The site controls apply to all sites in all wells at the same time. When you
turn on or off sites for a selected well, then all wells in the plate will have data
acquired for the same sites.

Note: You can configure automated data acquisitions for the wells as part of a
protocol. .
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7. Optionally, do one of the following as needed:

To manually adjust the spacing between adjacent sites, where the default value is
zero, or no spacing, enter the X and Y values for the spacing in the Spacing (µm)
fields.

To manually adjust the spacing between adjacent sites so that the sites overlap,
enter negative X and Y values for the spacing in the Spacing (µm) fields.

Note: The camera size limits these values, and therefore, the amount of
overlapping that you can specify.

To automatically adjust the spacing between adjacent sites so that there is zero
spacing between them, click Tile sites. The X and Y spacing values are set to zero.

To automatically adjust the spacing between the adjacent sites to themaximum
allowed value based on the selected plate type, click Fit sites to well. The X and Y
spacing values are updated accordingly.

To automatically overlap the sites by 10%, click Overlap Sites 10%. The X and Y
spacing values are updated to the appropriate negative values based on the selected
plate type.
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8. Specify the Adaptive Acquisition settings.

Setting Description

Minimum sites
to visit

The minimum number of sites to visit in a well. The MetaXpress Software
acquires at least this minimum number of sites and then it continues to acquire
sites until the total number of cells counted per well value as specified in the
Cell count per well field is reached.

Wavelength The wavelength that is used to differentiate nuclei in the source image.
Note: For the most efficient acquisition, this wavelength should be the same as
the wavelength that is designated as being the first to be acquired. See
Specifying the Number of Acquisition Wavelengths on page 80.

Approximate
width

The approximate minimum width and the approximate maximum width of the
nuclei that are expected to be detected.
Note: Nuclei patterns in the source image that fall below this range are
considered as noise. The algorithm might split larger objects that are above the
maximum width into smaller objects, which can affect the cell count.

Intensity
above local
background
gray levels

The intensity threshold of nuclei in the source image compared to the
neighboring background values. This setting controls the sensitivity of
detection.
Note: For information about setting the intensity threshold, see Calculating the
Intensity Above Local Background Gray Levels Value on page 72.

Note: The Approximate width and the Intensity above local background gray levelswork
together. A nucleus is determined by an object size and relative intensity above the
background.

Cell count per
well

The total number of nuclei in each well that the MetaXpress Software must
acquire before stopping acquisition of the well.
Note: The MetaXpress Software always acquires the minimum number of
sites, even if the Cell count per well can be acquired with a fewer number of
sites. As the Adaptive Acquisitionmode runs, a real-time count of the cells in
the currently selected well is displayed as the images are acquired. Adaptive
Acquisition stops acquiring when the maximum number of sites that have
been defined is reached, even if the specified cell count is not acquired.

Table 5-3: Adaptive Acquisition Settings
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9. Optionally, to determine if your current acquisition settings are appropriate for
differentiating nuclei, do the following:

Select an appropriate well and site for reviewing your settings.

Click Focus to bring the sample into focus.

Note: Focus does a large-range autofocus on the currently selected well and
site. To ensure that your cell counting settings are accurate, bring the sample
into focus before you click Test Segmentation.

Click Test Segmentation to snap an image and count the nuclei. Both an acquisition
image and the total number of cells that were counted in the image are displayed.

Figure 5-14: An example of Test Segmentation results in the Adaptive Acquisition
mode. The red shows the segmentation overlaid on the original DAPI image.

If your test results are satisfactory, then continue to the next step. Otherwise, repeat
Step 8 and Step 9 until your test results are satisfactory.

10. If you are done configuring your protocol, continue to Saving a Plate Acquisition
Protocol on page 112. Otherwise, continue to any other configuration as needed. See:

Plate Acquisition Setup Dialog: Configure Tab, Objective and Camera Tab on page 55.

Plate Acquisition Setup Dialog: Configure Tab, Plate Tab on page 56.

Plate Acquisition Setup Dialog: Configure Tab, Acquisition Tab on page 75.

Plate Acquisition Setup Dialog: Configure Tab, Display Tab on page 107.
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Calculating the Intensity Above Local Background Gray Levels Value

To calculate the Intensity above local background gray levels value, use the following
procedure:

1. If the Region toolbar is not open, then click Regions > Regions Tools (default menu), or
Measure > Regions > Regions Tools (simplified menu).

2. Select the Arrow tool as shown in the following figure:

Figure 5-15: Region tools on the Region toolbar

3. On the source image, locate one of the dimmest objects (for example, a nucleus, if
applicable) that theMetaXpress Softwaremust be able to detect.

4. Position your mouse pointer on the dimmest part of the object and make note of the
gray level value that is displayed in the status bar.
As you move the cursor, the X, Y coordinates and the gray level value of the pixel that is
under the cursor are indicated at the bottom of theMetaXpress Software desktop. The X
and Y coordinates are enclosed in parentheses and the gray level value is displayed to
the right. For example, (48, 158) -> 18000 indicates that 18000 is the average gray level
value of the pixel.

Figure 5-16: Gray level indicators

5. Position your mouse pointer just to the outside of the object and make note of the gray
level value that is displayed in the status bar.
For example, (48, 162) -> 2000 indicates that 2000 is the average gray level value of the
background just outside the object.

Tip: Instead of doing Step 4 and Step 5, you can draw a line region across a cell
and its local background, and then use the Linescan tool that is available from the
Measuremenu to seemore exact intensity values. For more information about
this tool, see theMetaXpress Software application help.

6. Subtract the gray level value of the background from the gray level value of the object.
Enter this value into the Intensity above local background field in this dialog.
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Configuring a Multi-Well Acquisition

To acquire high density plates faster, you can run a multi-well acquisition. Amulti-well
acquisition uses the size of the camera field of view to acquire several wells simultaneously
while taking a single image, thereby reducing plate acquisition time. TheMetaXpress
Software automatically calculates the number of wells in which a site can be simultaneously
acquired. This value depends on the plate well density and themagnification that is
configured for the protocol. Common configurations for multi-well acquisitions include a
1536-well plate with a 4xmagnification objective or a 384-well plate with a 2xmagnification
objective.

Note: During a multi-well acquisition, wells that are not selected might be exposed to
excitation light from imaging neighboring selected wells. However, images are not
saved for the wells that are not selected.

Figure 5-17: Plate Acquisition Setup dialog: Configure tab, Sites to Visit tab, Multi-well
option selected

Tip: As you are configuring an acquisition protocol, you can open the Summary panel
and leave it open to view the current values for all of the protocol settings.

1. Open the Sites to Visit tab.

2. SelectMulti-well.

3. Optionally, to specify a percentage of the field of view the camera will acquire, select
Custom Field of View (%), and then type the X (width) value and Y (height) value.
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Note: The full field of view for the camera is 100 percent (100% in the X field and
100% in the Y field). So, for example, if the full field of viewwidth is 1000 µm, then
to acquire a width of 500 µm, enter 50 in the X field.

Note: The Custom Field of View feature is compatible with full-size shading
correction images when using Legacy Correction.

Tip: This feature is particularly useful for acquiring images from an unevenly
illuminated full field, or for acquiring images that include the area outside the well
boundary.
ForMulti-well acquisitions, use the full field of view, because the Custom Field of
View value severely reduces the amount from each well acquired.

4. Use the platemap to specify a subset of wells within a plate for data acquisition. All active
wells are green in the platemap. Inactive wells are gray in the platemap.

To turn off a single well, click on a green well graphic. The well turns gray to indicate
that this well will be skipped during data acquisition. To turn it back on, click the well
again. The well turns green again.

To turn off a column of wells, click on the number header. The column of wells turns
gray to indicate that they will all be skipped during data acquisition. To turn them
back on, click the column header again. The wells turn green again.

To turn off a row of wells, click on the letter header. The row of wells turns gray to
indicate that they will all be skipped during data acquisition. To turn them back on,
click the letter header again. The wells turn green again.

To turn off a contiguous group of wells, click and drag the red-outline across the
group of wells for selection. The selection group turns gray. To turn them back on,
click and drag the red-outline across the group of wells for selection again. The wells
turn green again.

To turn off or on all wells in a plate in a single step, click the white triangle in the
upper-left corner of the platemap.

Note: You can preselect the wells for the acquisition as part of the automated
protocol, or you can select the wells at the time that you run the protocol.

5. If you are done configuring your protocol, continue to Saving a Plate Acquisition
Protocol on page 112. Otherwise, continue to any other configuration as needed. See:
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Plate Acquisition Setup Dialog: Configure Tab, Objective and Camera Tab on page 55.

Plate Acquisition Setup Dialog: Configure Tab, Plate Tab on page 56.

Plate Acquisition Setup Dialog: Configure Tab, Acquisition Tab on page 75.

Plate Acquisition Setup Dialog: Configure Tab, Display Tab on page 107.

Plate Acquisition Setup Dialog: Configure Tab, Acquisition Tab
At a minimum, you must specify the autofocus options and the acquisition wavelengths for
your protocol. Optionally, you can also specify various settings such as Run Journals During
Acquisition. Depending on the options that you select, other tabs with additional
configuration options can be displayed.
See:

Configuring Autofocus Options on page 75

Specifying the Number of Acquisition Wavelengths on page 80

Configuring Series Acquisition Options on page 91

Configuring Journals to Run During Acquisition on page 99

Configuring Post-Acquisition Analysis Options on page 103

Configuring Autofocus Options

Two configurable autofocus options are available on the Acquisition tab.

Laser-based Focusing is generally set to find the bottom of the well, and then moves the
objective a specified distance up from the well bottom. This method is generally the
fastest and does not cause photo damage to your wells. However, this method might
not be sufficient if the distance above the bottom of the well varies in your sample.
Thumbprints or scratches at the bottom of the plate affect focus performance.

Image-based Focusing uses a contrast-based algorithm to identify the best focus image.
This option works best for experiments that use low-power objectives or when the
sample distance above the bottom of the plate varies. Performance can be slower than
Laser-based Focusing and focusing can fail if out-of-focus debris is in a sample.

You can configure one or both of the Autofocus Options for a plate acquisition protocol.
Molecular Devices recommends primarily using Laser-based Focusing.
Certain types of samples can benefit from using both Image-based Focusing and Laser-based
Focusing, including live organisms, suspension cells, tissue samples, and assays where the
best focus position varies with the phenotype. When you select both focus options, the
Laser-based Focusing is used move the selected objective to a specified position above the
bottom of the well, and the Image-based Focusing is used to fine tune the focus.

Tip: As you are configuring an acquisition protocol, you can open the Summary panel
and leave it open to view the current values for all of the protocol settings.
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To configure autofocus options, use the following procedure:

1. Click Acquisition.

2. Under Autofocus options, select one or both options.

Enable laser-based focusing

Enable image-based focusing (for acquisition or laser recovery)

Note: Molecular Devices recommends using Image-based Focusingwith
complex samples that have variations in distance between the surface of the
plate and the sample.

3. Click Autofocus.

Figure 5-18: Plate Acquisition Setup dialog: Configure tab, Autofocus tab
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4. Configure the Autofocus options.

Options Description

Laser-based Focusing is available only if Enable laser-based focusing is selected on the
Acquisition tab.

Configure
Laser
Autofocus
Settings

Opens the Configure Laser Autofocus Settings dialog. The settings for this dialog
will have been calculated by running the Laser Autofocus Wizard. If the wizard
has not been run for a selected plate and objective, then the dialog will not
contain any values. You can modify the settings that the wizard has calculated for
this dialog.
Note: The MetaXpress Software help topic “Configure Laser Autofocus Settings -
Dialog Options” provides detailed information about the settings that the wizard
calculates. Press F1 with the dialog open to access the help. For tips about using
the Laser Autofocus Wizard, contact Technical Support for assistance. See
Obtaining Support on page 149.

Well to well autofocus adjusts the focus as the acquisition moves from well to well.
Note: Chamber slides with wells can use any of these options.

Focus on
well bottom

The default value and the recommended option for most plate acquisition
protocols.
The initial focus on the plate for finding the samples, focuses on both the plate
bottom and well bottom. As the system moves from well to well, the camera
focuses on the well bottom only, using values recorded in the Edit Plate Bottom
Settings option on the Plate tab to determine the focus range.

Focus on
plate
bottom,
then offset
by bottom
thickness

Offsets the focus laser by the Bottom thickness of the plate from the plate
configuration. Select this option if you are using any of the following:
– A thin-bottom plate with a large depth of field objective, needed because of
low magnification or low numerical aperture. This setting is generally used for
magnifications of 4x and below.
– A slide
– Multi-well acquisition

Focus on
plate and
well bottom

The laser focuses on both the plate bottom and the well bottom at every well.
Recommended setting for plates with extreme bottom variation.

Image-based Focusing

Algorithm: includes the following focusing algorithm options.

Standard Default algorithm, based on a standard group of settings including a normal
camera signal level.

Low Signal Based on a set of values designed to compensate for a low signal level on the
camera, and pixel intensities that are brighter when slightly out of focus.

Camera configuration options:

Table 5-4: Autofocus options
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Options Description

Binning Sets the binning used by the camera during Auto Focus and Show Live. Horizontal
and vertical binning are always set to the same value.

Custom
exposure
times

For individual wavelengths during autofocus. If this option is not selected, then
the exposure time is calculated based on autofocus binning and acquisition
exposure time. If this option is selected and you select either or both Laser and
Image or Laser with Image Recovery for the first acquisition wavelength (W1),
or Image-based for any subsequent acquisition wavelengths (W2, W3, and so
on), then you must also specify values for Exposure and Gain on the Wavelength
tabs. See Specifying the Number of Acquisition Wavelengths on page 80.

Allow
image-based
focusing for
recovery
from
laser-based
well bottom
failures

Enabled only if both Enable laser-based focusing and Enable image-based
focusing are selected.
Use Image-based focusing only if Laser-based focusing cannot find the plate or
well bottom.
The image-based recovery search is centered on an estimated well bottom offset
position.
The estimated position is calculated by using the plate bottom position that was
found during the last successful laser autofocus attempt, and then adding the
plate bottom thickness and post-laser offset values to this plate bottom thickness
value.

Initial well for finding sample:Sets the well to use for the first Find Sample autofocus.

First well
acquired

Finds the sample autofocus using the first well that is acquired.
Recommended setting for most protocols

Specific well Finds the sample autofocus using a well that you specify.
Note: After you select this option, you must specify the well row and column
number. A1 is the default value.

Skip Find
Sample
(select if
sample is
already in
focus)

Disables the initial Find Sample autofocus when starting to acquire a plate.
Select this option when your sample is already in focus.

Number of
wells to
attempt
initial find
sample

Enabled only if the First well acquired option is selected.
The first well in which a sample is found is the well that is used for autofocusing.
The default value is one.
Note: If you are using a robot for automated plate loading, set this value to three
or greater.

Site Autofocus is enabled only if Fixed number of sites or Adaptive Acquisition is selected on
the Sites to Visit tab. This section includes several options for configuring site-to-site autofocus.

Table 5-4: Autofocus options (continued)



Chapter 5: Configuring Plate Acquisition Options

5058342 B 79

Options Description

First site
only

Autofocuses in the top-left site in the well.

Center of
well only

Autofocuses in the center of the well.
Note: Select this option when the magnification is low and the sites are relatively
close together.

All sites Autofocuses for each site.
Note: Select this option with higher magnification, when the sites are spread far
apart, or there is extreme variation in the plate bottom.

Timelapse Autofocus is enabled only if Acquire Time Series is selected on the Acquisition tab.
See Configuring Series Acquisition Options on page 91.

First
timepoint
only

Use for fast kinetic acquisitions.

All
timepoints

Use for long timelapse acquisitions.

Every Nth
timepoint

Set a value that is less than the number of specified timepoints. See Configuring
Time Series Acquisition Options on page 92.

View
Focusing
Details

Opens the Auto Focus Details dialog, which lists the current autofocus
parameters. This information can be useful for diagnostic purposes when
troubleshooting focusing issues.
Click Copy to copy the parameters to the clipboard, and then paste them into a
third party application, such as Microsoft Word.

Table 5-4: Autofocus options (continued)

5. If you are done configuring your protocol, continue to Saving a Plate Acquisition
Protocol on page 112. Otherwise, continue to any other configuration as needed. See:

Plate Acquisition Setup Dialog: Configure Tab, Objective and Camera Tab on page 55.

Plate Acquisition Setup Dialog: Configure Tab, Plate Tab on page 56.

Plate Acquisition Setup Dialog: Configure Tab, Sites to Visit Tab on page 61.

Plate Acquisition Setup Dialog: Configure Tab, Display Tab on page 107.
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Specifying the Number of Acquisition Wavelengths

You specify the total number of acquisition wavelengths for an experiment on the
Wavelengths tab. You must specify at least one acquisition wavelength, but you can specify
up to a maximum of eight. You configure exposure time, autofocus, and timelapse settings
for each acquisition wavelength on an individual wavelength tab. Individual placeholder tabs
(W1,W2,W3, and so on) are enabled that correspond to the number of acquisition
wavelengths that you have set. For example, if you set theNumber of wavelengths to three,
then aW1 tab, aW2 tab, and aW3 tab are enabled. The red warning icon indicates that you
have yet to configure the acquisition wavelengths. See Figure 5-19.

Figure 5-19: Plate Acquisition Setup dialog: Configure tab, Wavelength tab: Three
placeholder Wavelength tabs

Tip: As you are configuring an acquisition protocol, you can open the Summary panel
and leave it open to view the current values for all of the protocol settings.
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To specify the number of acquisition wavelengths, do the following:

1. Click theWavelengths tab.

Note: TL Legacy Shading Correction Refinement Level is always displayed on the
Wavelengths tab. The default value is two. This option is applied only if
Autocorrect for TL Legacy is selected for Shading Correction for one or more
acquisition wavelengths. The larger the value for the refinement level, the flatter
the transmitted light image will be, however increasing this value will slow the
acquisition routine. The single value that is specified here applies to all acquisition
wavelengths for which Auto Correction for TL Legacy is selected as the shading
correction method. See Shading Correction on page 88.

2. In theNumber of wavelengths field, specify the total number of wavelengths that are to
be used for acquisition, where theminimum value is one and themaximum value is
eight.

3. Configure each acquisition wavelength. See Configuring an Acquisition Wavelength on
page 82.
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Configuring an Acquisition Wavelength

Tip: For efficiency, configure the acquisition wavelengths in the order that minimizes
filter movement. The order in which you configure the acquisition wavelengths
corresponds to the acquisition order. For example, if you configure theW1 tab as a
DAPI wavelength and then configure theW2 tab as a FITC wavelength, then the DAPI
acquisition wavelength runs first and the FITC acquisition wavelength runs second.

For each individual wavelength placeholder tab, do the following in the order listed:

1. Click the individual wavelength tab, for example,W1.

2. In the Illumination setting field, select the illumination wavelength, for example, DAPI.
The selection name is displayed in the Active Wavelength field under the platemap, and
on the individual tab.

Figure 5-20: Plate Acquisition Setup dialog: Configure tab, Wavelength tab: Setting
placeholder Wavelength tab
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3. Configure the remaining acquisition wavelength options, where:
Offset (µm) is the Z motor offset distance for each wavelength that is defined. For the
first wavelength, if you are using laser-based focusing, then the offset is the distance
between the bottom of the well and the in-focus plane. If you are using just image-based
focusing, then no offset is required for the first wavelength. For the second and
subsequent wavelengths, with laser-based or image-based focusing, the offset is the
difference between the focus position of the Z motor using the first wavelength and the
focus position of the Z motor using the second or subsequent wavelength.

Options Description

Bright
Sample

If your sample has a high intensity, but a low (1 ms to 7 ms) exposure time, then
select this option to reduce the light power for the selected acquisition
wavelength and prevent saturation of the sample. After you select this option,
adjust your exposure time accordingly to control the precision of the sample
brightness.

Exposure
(ms)

Specifies the exposure time in milliseconds for the active wavelength. You can
type a value in this field or click Auto Expose to automatically determine an
exposure time. Exposure times should be determined using an in-focus image.
Note: When you are configuring exposure times, check both the positive and the
negative controls. If you use a dim sample to set the exposure time, then a bright
sample might become saturated.

Auto Expose Click to automatically set the exposure time that is required to obtain the Target
max intensity. If Auto Expose results in a 1 ms to 5 ms value to achieve this
intensity, then you are automatically prompted to activate Bright Sample mode
to prevent saturation of your sample. Click Yes to turn on Bright Sample mode
and automatically rerun Auto Expose, or click No to leave all settings as-is.
Note: Auto Expose is a manual tool to help configure the plate. This feature does
not enable automatic exposure adjustments while the plate is being acquired.
Exposure times should be determined using an in-focus image.

Target max
intensity

Specifies the intensity that Auto Expose should attempt to attain for the brightest
pixel in the image.
Note: The recommended target intensity value is 75% of the maximum gray
level that is possible with your camera driver. For the ImageXpress Nano System,
the optimal value should be approximately 3300.

Autofocus options specify the type of autofocus that is to be used when acquiring images. The
available options depend on the acquisition options that are selected on the Acquisition tab.

None No autofocusing is done. If you select this option, then no other autofocusing
configuration options are available.

Table 5-5: Acquisition Wavelength Setting Options
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Options Description

Laser with
Z-offset

Displayed as an option only if Enable laser-based focusing is selected on the
Acquisition tab. If selected, then the Laser-based Focusing is used based on the
settings that the Laser Autofocus Wizard calculates, or as configured using
Configure Laser Settings on the Acquisition tab. Specify the Post-laser offset
value in µm, or click Calculate Offset to automatically calculate the first (W1)
wavelength offset.

Calculate
Offset icon
(>)

Click > to display the options that are used for calculating the post-laser offset
value.
Use Z stack enables the capture of multiple Z plane images so that you can select
the best in-focus plane.
Note: WithoutUse Z stack, MetaXpress Software carries out an image autofocus
and determines the best in-focus plane.
Custom Range determines the total search range and step size for calculating the
offset.
Note: Without Custom Range, the default values, based on the current objective,
are used for the Calculate Offset tool using either Z stack or image autofocus.

Laser And
Image

Displayed as an option for only the first acquisition wavelength (W1) and only if
Enable laser-based focusing and Enable image-based focusing are selected on
the Acquisition tab. If selected, the laser autofocuses first, and then image-based
focusing fine tunes the focus. You must also specify values for the following:
Image-based range +/- µm specifies the search range for the image-based
portions of autofocusing.
Max. step specifies the maximum step size of a single Z move in µm that is
required to get the correct focus position. This setting depends on the objective
that is used. Because the focus peak is narrower, use a smaller step size with
higher NA objectives.
If Custom exposure time is selected on the Autofocus tab, then with Laser and
image selected, you must also specify values for the following:
Exposure (ms) specifies the exposure time in milliseconds for the acquisition
wavelength when autofocusing.

Table 5-5: Acquisition Wavelength Setting Options (continued)



Chapter 5: Configuring Plate Acquisition Options

5058342 B 85

Options Description

Laser with
Image
Recovery

Displayed only for the first acquisition (W1) wavelength and only if Enable laser-
based focusing and Enable image-based focusing are selected on the Acquisition
tab and Allow image-based focusing for recovery from laser-based well bottom
failures is selected on the Autofocus tab.
When selected, you must also specify the following options:
Image-based range +/- µm specifies the range that is to be used for the image-
based portions of autofocusing.
Note: You should adjust the range based on the sample variability. A larger range
requires a longer time to focus.
Max. step specifies the maximum step size in µm of a single Z move that is to be
used to get the correct focus position. This setting is dependent on the objective
that is used. Because the focus peak is narrower, use a smaller step size with
higher NA objectives.
Note: Smaller step sizes generally require more steps to arrive at the final focus
position. Increasing the number of image autofocus steps increases the chances
of photobleaching or phototoxicity.
If Custom exposure time is selected on the Autofocus tab, then with Laser with
Image Recovery selected, you must also specify values for the following:
Exposure (ms) specifies the exposure time in ms that is to be used for the
acquisition wavelength when autofocusing.

Z-offset
from W1

Available only for the second or later (W2, W3, and so on) acquisition
wavelengths. The offset for W1 must be calculated before you can set this value.
Selecting this option moves the W1 focus position to the specified offset. Specify
the post-laser offset in µm in the Offset field, or click Calculate Offset to
automatically calculate the offset for all subsequent acquisition wavelengths.

Table 5-5: Acquisition Wavelength Setting Options (continued)
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Options Description

Image-based Available for the second or greater (W2, W3, and so on) acquisition wavelengths
and only if Enable image-based focusing is selected on the Acquisition tab.
Specify the Z-offset from W1 in µm in the Offset field, or click Calculate Offset to
automatically calculate the offset that is to be used for all subsequent acquisition
wavelengths. If this option is selected, then you must also specify the following
options:
Image-based range +/- µm specifies the range that is to be used for the image-
based portions of autofocusing.
Note: You should adjust the range based on the sample variability. A larger range
requires a longer time to focus.
Max. step specifies the maximum step size in µm of a single Z move that is to be
used to attain the correct focus position. This setting is dependent on the
objective that is used. Use a smaller step size with higher NA objectives because
the focus peak is narrower.
Note: Smaller step sizes generally require more steps to arrive at the final focus
position. Increasing the number of image autofocus steps increases the chances
of photobleaching or phototoxicity.
If Custom exposure times is selected on the Autofocus tab, then with
Image-based selected, you must also specify values for the following:
Exposure (ms) specifies the exposure time in milliseconds that is to be used for
the acquisition wavelength when autofocusing.

Acquisition options are displayed depending on the Series option selected under Acquisition
options on the Acquisition tab.

Acquire
Time Series
enables
Timelapse

Specifies the image collection intervals to use for the selected wavelength.
at all time points is the default value. This setting enables acquisition of an image
using the selected wavelength at each time point in the experiment.
at start of experiment acquires an image using the selected wavelength at the
first time point only.
at start/end of experiment acquires an image using the selected wavelength at
the first time point and the last time point for the experiment.
every nth timepoint acquires an image using the selected wavelength at the
indicated time point interval, for example, every 5th time point, beginning with
the first time point for the experiment.

Table 5-5: Acquisition Wavelength Setting Options (continued)
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Options Description

Acquire Z
Series
enables Z
Series

Single plane acquires only a single plane based on the autofocus options for the
selected wavelength, just as if the Acquire Z Series option were disabled. It is
used in a multi-wavelength acquisition when the Z Series acquisition is not
required for the selected wavelength.
2D Projection Image Only acquires the Z Series, and a single projection image,
which is saved.
Z Series and 2D Projection Image acquires the Z Series, and generates a
projection image; in this case all individual Z plane images as well as the
projection are saved. This option is only available if Acquire Time Series is
cleared and Acquire Z Series is selected in the Acquisition tab.

2D
Projection
Image

Available for all Z Series acquisition options other than Single Plane indicates how
the resulting 2D projection image is generated.
Best Focus is the default value. The MetaXpress Software estimates the regions
of best focus in the image stack to within one-tenth pixel accuracy along the Z
axis. Two resolution grid sizes are used to enhance the criterion of focus through
the stack.
Maximum is recommended only for fluorescence. For each corresponding pixel
position in the images, the pixel that has the highest intensity value out of all the
planes is determined, and this is the value that is output to the resulting image.
Minimum is recommended only for transmitted light. For each corresponding
pixel position in the images, the pixel that has the lowest intensity value out of all
the planes is determined, and this is the value that is output to the resulting
image.
Sum is the intensities of the pixels in the stack planes are added for each
corresponding pixel position, and this is the value that is output to the resulting
image.
Note: If the sum overflows the 16-bit image capacity, then a warning message
opens that indicates that the maximum possible intensity of 65535 was
exceeded. The MetaXpress Software cuts the pixels off at this value as a result.

Digital
Confocal

Enabled only if your organization has purchased the optional Digital Confocal
feature. Select to do on-the-fly deconvolution-based image sharpening.
Note: For information about the Digital Confocal option, go to
http://www.moleculardevices.com/support, click on the Knowledge Base link,
and search for “Digital Confocal.”

Table 5-5: Acquisition Wavelength Setting Options (continued)

http://www.moleculardevices.com/support


ImageXpress Nano System with MetaXpress Software User Guide

88 5058342 B

Options Description

Shading
Correction

Indicates whether shading correction has been enabled for the acquisition
wavelength. Options are the following, where FL represents fluorescence and TL
represents transmitted light:
Off indicates that no shading correction is done.
Auto Correction for FL is the most complete approach. It does both a shading
correction and a background subtraction. Background subtraction removes stray
light that is unrelated to the light that is emitted by the sample. The shading
correction is tuned for fluorescence and adjusts for uneven illumination of the
sample. The shading reference is generated once and applied over all samples.
FL Subtraction Only does the background subtraction but not shading correction.
Use this method at high magnification, or when there is a concern about the
algorithm being able to correctly determine background, which can occur if the
fluorescent target takes up the majority of the field of view. For example, in a
scenario in which images were being taken of a tissue sample and the sample of
interest covered the entire field of view, then the shading algorithm might
interpret some of the signal as shading and slightly over-correct the image.
FL Shading Only does only shading correction. It does not do background
subtraction. The shading correction is tuned for fluorescence. The shading
reference is generated once and applied over all samples. Recommended
selection.
Auto Correction for TL is a shading algorithm for transmitted light images that has
faster performance and improves the flatness compared to Auto Correction for
TL Legacy. It does shading correction but not background subtraction. This option
does not use the TL Legacy Shading Correction Refinement Level on the
Wavelengths tab. The shading reference is collected at every site.
Auto Correction for TL Legacy is a shading algorithm that is specifically tuned for
transmitted light instead of fluorescence. It does shading correction but not
background subtraction. If you select this option, then you must set the TL Legacy
Shading Correction Refinement Level on the Wavelengths tab. The shading
correction uses this value to flatten the images as they are captured. The shading
reference is collected at every site. See Specifying the Number of Acquisition
Wavelengths on page 80.
Legacy Correction is an option that was also available in earlier versions of the
MetaXpress Software. This option requires the use of preset magnification,
illumination, and acquisition mode reference images that are located in a
specified directory. See Correcting Image Shading on Acquired Images—Legacy
on page 89.
Note: The new methods are recommended over the Legacy Correctionmethod.
With the new methods, correction is always based on the current state of the
system and is not subject to variation over time.

Table 5-5: Acquisition Wavelength Setting Options (continued)



Chapter 5: Configuring Plate Acquisition Options

5058342 B 89

4. If you are done configuring your protocol, continue to Saving a Plate Acquisition
Protocol on page 112. Otherwise, continue to any other configuration as needed. See:

Plate Acquisition Setup Dialog: Configure Tab, Objective and Camera Tab on page 55.

Plate Acquisition Setup Dialog: Configure Tab, Plate Tab on page 56.

Plate Acquisition Setup Dialog: Configure Tab, Sites to Visit Tab on page 61.

Plate Acquisition Setup Dialog: Configure Tab, Display Tab on page 107.

Correcting Image Shading on Acquired Images—Legacy

Note: The following information is applicable if Legacy Correction is selected as the
shading correction method for an acquisition wavelength. See Configuring an
Acquisition Wavelength on page 82.

Before you can do legacy shading correction, the appropriate shading correction images
must have been acquired for each acquisition wavelength and saved to a directory that has
been specified as the Stored Correction Images directory. During your initial on-site system
installation, the shading correction image files are configured to be found in the C:\Shading
Images folder, but you have the option of changing this default directory. See Verifying
Shading Correction Files-Legacy on page 42.

Tip: If a shading correction image was acquired with the full field of view, then you can
use the Custom Field of View feature on the Plate tab with shading correction. See
Plate Acquisition Setup Dialog: Configure Tab, Plate Tab on page 56.
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To change the default directory location for shading correction images, use the following
procedure:

1. Click Acquisition.

Figure 5-21: Plate Acquisition Setup dialog, Configure tab, Acquisition tab

2. Click Directory for Stored Correction Images, and then in the Browse for Folder dialog,
select the new location.

3. Click OK to close the dialog and return to the Acquisition tab.

4. If you are done configuring your protocol, continue to Saving a Plate Acquisition
Protocol on page 112. Otherwise, continue to any other configuration as needed. See:

Plate Acquisition Setup Dialog: Configure Tab, Objective and Camera Tab on page 55

Plate Acquisition Setup Dialog: Configure Tab, Plate Tab on page 56

Plate Acquisition Setup Dialog: Configure Tab, Sites to Visit Tab on page 61

Plate Acquisition Setup Dialog: Configure Tab, Display Tab on page 107.
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Configuring Series Acquisition Options

Two series acquisition options are available for configuration on the Acquisition tab.

Acquire Time Series acquires images at multiple time points. When selecting this option,
you must also specify the set of images that are to be acquired at each time point.

Acquire Z Series acquires individual optical sections (planes) in sequence through a
sample that can be used to produce a 3-D image of the sample. When selecting this
option, you must also specify the number of steps and the step size for moving through
the sample.

You can select one or both of these options.

Tip: As you are configuring an acquisition protocol, you can open the Summary panel
and leave it open to view the current values for all of the protocol settings.

1. Click Acquisition.

Figure 5-22: Acquisition Setup dialog, Configure tab, Acquisition tab, Acquisition
options, Series options

2. Under Acquisition options, select one or both of the following:

Acquire Time Series

Acquire Z Series
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3. Continue according to your selection:

For Acquire Time Series, continue to Configuring Time Series Acquisition Options on
page 92.

For Acquire Z Series, continue to Configuring Z Series Acquisition Options on page
95.

Configuring Time Series Acquisition Options

1. Click Timelapse.

Figure 5-23: Plate Acquisition Setup dialog, Configure tab, Timelapse tab
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2. Configure the time series acquisition options.

Options Description

Number of timepoints Specifies the total number of time points that are to be
acquired. The default value is one. If you change this value,
then the Duration field is automatically updated by
calculating the Duration from the Number of time points
and the Interval.

Perform time series for is enabled only when the value for the Number of time points is > 1. It
specifies the loop order that is to be used for acquiring images at multiple time points and also
defines the time interval and total length of the time lapse acquisition routine.

One well then the next Acquires a set of wavelength images at each site in the well
at each time point.
Note: This option is most common with a photoactivation
event.

One row then the next Collects all the images that are in one row of wells at each
time point. After the series is collected, the next row is
acquired.
Note: This option requires a longer time interval because all
the wells in a row are acquired.

One column then the next Collects all the images in one column of wells at each time
point. After the series is collected, the next column is
acquired.
Note: This option requires a longer time interval because all
the wells in a column are acquired.

All selected wells Specifies that all selected wells will be acquired at each time
point in the acquisition routine.
Note: This option requires a longer time interval because all
the wells in the plate are acquired.

Note: Any refocusing that is done after the images for the first timepoint are acquired is
determined by the Timelapse Autofocus setting that is specified on the Autofocus tab. See
Configuring Autofocus Options on page 75.

Table 5-6: Times series acquisition options
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3. In the Interval field, type the amount of time between the start of an acquisition at one
timepoint and the start of an acquisition at the next time point. The default unit of time
is seconds (sec), but you can select milliseconds (ms), minutes (min), or hours (hr).

Note: The Approximate minimum time interval value is calculated as the sum of
the exposure times per time point based on the well selection, site selection,
wavelength settings, and loop order selection. If the actual acquisition time for
one loop exceeds the Interval value, then the next timepoint starts as soon as the
previous timepoint finishes.

Note: TheDuration value results from multiplying the number of time points by
the interval. If you change theNumber Of Timepoints value, or the Interval
value, then the value in theDuration value is automatically updated.

4. Optionally, change theDuration value.

Note: The time unit for theDuration value does not have to be the same as the
time unit for the Interval value. If you change the value for Duration, then the
value forNumber of timepoints is automatically updated.

5. If you are done configuring your protocol, continue to Saving a Plate Acquisition
Protocol on page 112. Otherwise, continue to any other configuration as needed. See:

Plate Acquisition Setup Dialog: Configure Tab, Objective and Camera Tab on page 55.

Plate Acquisition Setup Dialog: Configure Tab, Plate Tab on page 56.

Plate Acquisition Setup Dialog: Configure Tab, Sites to Visit Tab on page 61.

Plate Acquisition Setup Dialog: Configure Tab, Display Tab on page 107.
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Configuring Z Series Acquisition Options

1. Click Z Series.

Figure 5-24: Plate Acquisition Setup dialog: Configure tab, Z Series tab showing the Z
Series diagram

Tip: The blue horizontal bars displayed on the Z series ruler diagram represent the
planes that will be acquired for each site imaged. The distance between these bars
is calculated based upon the value entered in the Step Size field.
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2. Configure the Z series acquisition options.

Option Description

# of Steps The number of planes at a given site or well position for which images are to
be taken. For example, if set to 12, which is the default value, then 12 images
will be taken along the Z axis of the sample. You can do the following to adjust
this value:
–Manually type a value in the field.
–Click the Up or Down arrows in the field.
–Drag the slider bar that is displayed below the field.

Step Size The distance in µm between the image planes in the Z series. You can do the
following to adjust this value:
–Manually type a value in the field.
–Click the Up or Down arrows in the field.
–Drag the slider bar that is displayed below the field.
Note: Based on the numerical aperture (NA) setting for the objective, the
MetaXpress Software automatically calculates a recommended Step Size that
would provide the best detail for your Z series. You can click this
Recommended Step Size message to automatically set the Step Size to this
recommended value.

Note: As you adjust one or both of these values, then the MetaXpress Software automatically
calculates the Range, which is the overall image depth from top to bottom of the image sample,
and displays this value below the Step Size on the tab.

Table 5-7: Z series acquisition options
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3. Optionally, to navigate the Z Series for a site or well position and modify the coordinates
for the Z motor before you acquire any images, do any of the following as needed:

Figure 5-25: Z Series diagram

Drag the Ruler Zoom slider bar that is displayed below the Z series diagram to zoom
in or zoom out on the diagram.

Tip: Alternatively, you can zoom in and out on the ruler by placing your
cursor over the ruler and using the scroll wheel on your mouse.

Focus is displayed on the Z series diagram to indicate the position of the Z motor
after autofocusing and wavelength offsets are applied. You can modify the Z stack
acquisition settings using the following steps:

Click the Focus active wavelength tool to place the Z motor at the Focus
indicator in the Z series diagram and display its current position in µm. The ruler
markings indicate the distance in µm above and below the Focus position.

Drag the Top or Bottom flags to manually set the top and bottom positions for
the Z series acquisition relative to the Focus position. As you manually adjust
one or both of these values, theMetaXpress Software automatically calculates
and displays the appropriate values for the # of Steps and the Range. The
position in µm to which a flag is moved is temporarily displayed on the flag.

Select Center Z Series Around Focus Result to evenly space the Z series planes
above and below the Focus position. Now, when you drag a Top or Bottom flag on
the Z series diagram to manually set the position for the Z series acquisition, the
MetaXpress Software automatically moves the other position by exactly the same
total distance in µm.
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Drag the Current Position flag on the Z series diagram to update the current position
for the Z motor. After you move the flag, you can then click Set T or Set B to set the
top and bottom positions respectively.

Note: If the Current Position flag is not displayed, use the Focus active
wavelength tool first.

Tip: Use this function with the Start Live active wavelength tool. Click Start
Live, and then with the Focus set, click and drag the Current Position flag to
view the different positions in an image in real time. Using this approach you
can interactively visualize the location for the top of the cells in the sample.
You could then click Set T on the Current Position flag to accurately set the
position for the top of an image.

Click on a blue bar in the Z series diagram to move the Current Position flag to this
plane. (This flag indicates the current position for the Z motor.)When you are in Live
mode, when you click on different planes in the Z series diagram, the image in the
Snapwindow is updated accordingly.

Tip: In Testmode, when you capture a Z stack, an image window appears.
Click and drag the slider bar at the top of the dialog to scroll through the Z
stack images.
Using Start Livemode only shows the current selected plane. To change the
current plane view, click on the step markers in the ruler on the Z tab.

To move the Z motor up or down one step at a time by the recommended Step Size,
click the small step size arrows, which are the small black vertical arrows to the right
of the Z series diagram. To move the Z motor up or down one step at a time by the
defined Step Size, click the large step size arrows, which are the large black vertical
arrows to the right of the Z series diagram. If you click and hold a step size arrow,
then the Z motor is moved continuously.

4. If you are done configuring your protocol, continue to Saving a Plate Acquisition
Protocol on page 112. Otherwise, continue to any other configuration as needed. See:

Plate Acquisition Setup Dialog: Configure Tab, Objective and Camera Tab on page 55.

Plate Acquisition Setup Dialog: Configure Tab, Plate Tab on page 56.

Plate Acquisition Setup Dialog: Configure Tab, Sites to Visit Tab on page 61.

Plate Acquisition Setup Dialog: Configure Tab, Display Tab on page 107.
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Configuring Journals to Run During Acquisition
You use the Journals tab to configure specific journals to run during different stages of the
acquisition. Only one journal configuration can be assigned per acquisition step.

Tip: As you are configuring an acquisition protocol, you can open the Summary panel
and leave it open to view the current values for all of the protocol settings.

1. Click Acquisition.

2. Select Run Journals During Acquisition.

Figure 5-26: Plate Acquisition Setup dialog: Configure tab, Acquisition tab

3. Click Journals.
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4. Select an Acquisition Step for the journal to run.

Figure 5-27: Plate Acquisition Setup dialog: Journals tab, Acquisition Step Selection
and Loaded Journal

Option Description

Before each
image

Runs only during the acquisition loop, after the illumination is set and focusing is
complete.

After each
image

Runs only during the acquisition loop, after the shutter is closed and before
images are saved.

Before
focusing

Runs only during the acquisition loop, just before the focus step begins.

Start of z Runs before a Z series is acquired. The journal runs when the Z motor is at the
lowest step in the series and before an image is acquired. The journal runs once
for each wavelength that is configured to use the Z series.

End of z Runs after a Z series acquisition is completed. The journal runs when the Z
motor is at the highest step in the series and after any projection images are
generated. The journal runs once for each wavelength that is configured to use
the Z series.

Start of site Runs only during the acquisition loop, before any images are acquired from
each site.

Table 5-8: Journal acquisition steps
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Option Description

End of site Runs only during the acquisition loop, after all images have been acquired from
each site.

Start of well Runs only during the acquisition loop, at the beginning of each well, before any
images are acquired from a well.

End of well Runs only during the acquisition loop, at the end of each well, after all images
have been acquired from a well.

Start of time
point

Runs only during the acquisition loop, at the beginning of each time point,
before any images are acquired for each time point.

End of time
point

Runs only during the acquisition loop, at the end of each time point, after all
images have been acquired for each time point.

Start of plate Runs after the stage is moved to the find sample position, but before the find
sample step is performed.

End of plate Runs after the last image acquisition for a plate is complete.

Prevent
asynchronous
hardware
moves

(Optional) Select this option only if a selected journal moves hardware, such as
changing filters, or moving focus.
This option ensures that the journals run correctly.
Note: Do not select this option without the use of a journal because it can slow
the acquisition.

Table 5-8: Journal acquisition steps (continued)

5. Click the folder icon for the selected acquisition step.
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6. In the Select Plate Acquisition Journal dialog, select a listed journal file.

Figure 5-28: Select Plate Acquisition Journal dialog

7. Click Open to close the Select Plate Acquisition Journal dialog and return to the Journal
dialog.

8. If you are done configuring your protocol, continue to Saving a Plate Acquisition
Protocol on page 112. Otherwise, continue to any other configuration as needed. See:

Plate Acquisition Setup Dialog: Configure Tab, Objective and Camera Tab on page 55.

Plate Acquisition Setup Dialog: Configure Tab, Plate Tab on page 56.

Plate Acquisition Setup Dialog: Configure Tab, Sites to Visit Tab on page 61.

Plate Acquisition Setup Dialog: Configure Tab, Display Tab on page 107.
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Configuring Post-Acquisition Analysis Options
You can select a specific analysis to run on a plate after the acquisition is complete on the
Analysis tab. If you select this option, then the analysis job is added to the Auto Run queue
in theMDCStore database for analysis either by MetaXpress Software that is set to Auto Run
mode or by theMetaXpress PowerCore Software. You can select from a list of saved assays
and settings files from any application module, custom module, or journal assay that has
been saved to theMDCStore database.

Tip: As you are configuring an acquisition protocol, you can open the Summary panel
and leave it open to view the current values for all of the protocol settings.

1. Click Acquisition.

Figure 5-29: Plate Acquisition Setup dialog, Configure tab, Acquisition tab

2. Select Analyze Images Immediately After Acquisition.
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3. Click Analysis.

Note: The options that are displayed on the Analysis tab depend on the series
acquisition mode (Acquire Time Series or Acquire Z Series) that is selected on the
Acquisition tab as well as the image that is to be acquired and retained: Single
plane, 2D Projection Image Only, or Z Series and Projection Image.

Figure 5-30: Plate Acquisition Setup dialog: Configure tab, Analysis tab (Time Series)
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Figure 5-31: Plate Acquisition Setup dialog: Configure tab, Analysis tab (Z Series and
2D Projection Image Only)

4. On the Analysis drop-down list, select the analysis protocol to run post-acquisition.

Note: This list includes any application modules, custom modules, or journal
assays that have been saved to theMDCStore database. The list of available
assays is the same list that is available on the Run Analysis tab in the Review
Plate Data dialog. Keep in mind that only application modules and custom
modules are compatible with MetaXpress PowerCore Software. Journal-based
analysis can only be run within MetaXpress Software.

5. On the Setting drop-down list, select the appropriate settings file for this module or
journal assay.

Note: The list includes all setting files that have been previously saved to the
MDCStore database.
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6. Specify the acquisition time points for which the analysis is to be run.

Option Description

All time points The default value. Analyze all the acquisition time points.

Time point range Analyze only those acquisition time points that fall within the indicated
range.

Stack of all time
points

Available if the selected analysis is a journal.

Table 5-9: Time point options - Time series acquisition

Option Description

All time points The default value. Analyze all the acquisition time points.

Time point range Analyze only those acquisition time points that fall within the indicated
range.

Stack of all time
points

Available if the selected analysis is a journal.

Table 5-10: Time point options - Time series acquisition with Z series acquisition for
at least one acquisition wavelength; 2D Projection Image Only

Option Description

All Z points The default value. Analyze all of the captured Z planes.

Z step range Analyze only those Z plane images that fall within the indicated range.

Stack of all Z steps Available if the selected analysis is a journal.

Projection Image Analyze only the projection image.

Table 5-11: Z step options - Z series acquisition for at least one acquisition
wavelength; Z Series and 2D Projection Image

7. If you are done configuring your protocol, continue to Saving a Plate Acquisition
Protocol on page 112. Otherwise, continue to any other configuration as needed. See:

Plate Acquisition Setup Dialog: Configure Tab, Objective and Camera Tab on page 55.

Plate Acquisition Setup Dialog: Configure Tab, Plate Tab on page 56.

Plate Acquisition Setup Dialog: Configure Tab, Sites to Visit Tab on page 61.

Plate Acquisition Setup Dialog: Configure Tab, Display Tab on page 107.
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Plate Acquisition Setup Dialog: Configure Tab, Display Tab
You configure the settings for theMetaXpress Software desktop appearance such as image
size and positions, the Plate Acquisition Setup dialog size and position, and other image
properties during acquisition on theDisplay tab. You can choose to display images only
during autofocus, only during acquisition, or both. You can also choose to display a color
overlay of wavelength images during acquisition.

Figure 5-32: Plate Acquisition Setup dialog: Configure tab, Display tab
For a description of the options on this tab, see Table 5-12: Display Settings on page 108.
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Options Description

Auto Arrange Images Use the MetaXpress Software default settings for displaying images and
dialogs during acquisition. Images autoscale and are arranged in a default
layout, and the status dialog is unobstructed.
Note: Use the Active Wavelength Preview tool to generate a preview of an
acquired image for each configured acquisition wavelength.

Display Acquisition
Layout

Displays the current settings for displaying images and dialogs during
acquisition. The Plate Acquisition Status dialog also opens. You can
manually change the display configuration using a variety of options for this
preview.
Click OK to register the changes, or Cancel to revert to the previous
settings.
Note: Display settings are saved with the acquisition protocol.

Display images during
autofocus

Selected by default. Displays the images that are acquired during image
autofocus.

Display images during
acquisition

Selected by default. Displays each image as it is acquired.

Display a color overlay
of wavelength images
during acquisition

Displays a color composite of the images captured for each selected
wavelengths that are acquired at each site.

Table 5-12: Display Settings
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Configuring the Display Settings for an Acquisition Protocol

Tip: As you are configuring an acquisition protocol, you can open the Summary panel
and leave it open to view the current values for all of the protocol settings.

1. Click Display.

2. To use theMetaXpress Software default settings for displaying images during
acquisition, click Auto Arrange Images.

3. Optionally, select or clear any or all the image preview options:

Display images during autofocus

Display images during acquisition

Display a color overlay of wavelength images during acquisition

4. To display the current settings for displaying images and dialogs during acquisition, click
Display Acquisition Layout.

Figure 5-33: Display Settings tab, Display Acquisition Layout Settings

5. Leave the images in this default layout, or optionally, manually adjust them by doing any
of the following:

Note: If the image windows are not visible, then click the ActiveWavelength
Preview to display an image window for each configured acquisition wavelength.

Rearrange the position of the image windows.

Change the size of the image windows.

Use the Previewwindow tools to change the size, scaling, or LUT for an image.
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6. To save the changes, click OK or to revert to the previous settings, click Cancel . Display
settings are saved with the acquisition protocol.

Note: Adjustments to images displayed as a result of the active wavelength tools,
like Snap or Focus, change the display settings.

7. If you are done configuring your protocol, continue to Saving a Plate Acquisition
Protocol on page 112. Otherwise, continue to any other configuration as needed. See:

Plate Acquisition Setup Dialog: Configure Tab, Objective and Camera Tab on page 55.

Plate Acquisition Setup Dialog: Configure Tab, Plate Tab on page 56.

Plate Acquisition Setup Dialog: Configure Tab, Sites to Visit Tab on page 61.

Plate Acquisition Setup Dialog: Configure Tab, Acquisition Tab on page 75.
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Viewing the Summary Panel
The Summary panel displays a summary of all the current acquisition settings. The Summary
panel is displayed to the right of the Plate Acquisition Setup dialog. By default, when the
Plate Acquisition Setup dialog first opens, the Summary panel is closed.

1. At the bottom of the Plate Acquisition Setup dialog, click Summary >> to open the
panel.

2. Optionally, do any or all of the following as needed:

Use the scroll bar to the right of the Summary panel to scroll up and down through
the content.

Click Copy to copy the contents to your clipboard, and paste the contents into
another program, such as Microsoft Word. 

Click Print to send the contents to a selected printer.

Figure 5-34: Plate Acquisition Setup dialog with open Summary panel

3. When you are done using the Summary panel, you can leave it open during the entire
process of configuring an acquisition protocol, or you can click << Summary to close it.
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Saving a Plate Acquisition Protocol
When you save a plate acquisition protocol, you have the option of saving the protocol to a
database or to a file. The default location is to save to a database. Your organization should
determine whether to save the protocol to a database or a file. For example, if your
organization plans on integrating your ImageXpress Nano System with a robot for
automated plate loading, then you must save the protocol to a file.

Saving a Plate Acquisition Protocol to a Database

1. Click Save Protocol.

2. On the Save Acquisition Protocol dialog, in the Protocol Name field, type a name for
the protocol.

3. Click Save.

You can now acquire your plate data with the saved protocol.

Saving a Plate Acquisition Protocol to a File

When you save a protocol to a file, the file type is .HTS and must not be changed. The default
location for saving a protocol is C:\MX6\HTSSTATE, but you can select a different location.

1. Click Save Protocol.

2. On the Save Acquisition Protocol dialog, select Save to file rather than database.

3. Click Save.

4. On the Plate Acquisition Setting dialog, in the File name field, type a name for the
protocol.

5. Optionally, select a different location in which to save the file.

6. Click Save.

You can now acquire your plate data with the saved protocol.
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Chapter 6: Customizing the MetaXpress Software

A powerful feature of theMetaXpress Software is the ability to customize the operation of
the software for individual users or groups of users. Various objectives and workflows call for
customized settings. Programs within theMetaXpress Software Suite, such as theMeta
Imaging Series Administrator Software and the Create Taskbar command, let you create
settings that match the needs of your users. The following topics are included this section:

Users and Groups in theMeta Imaging Series Administrator Software, see page 113

Custom Toolbars and Taskbars, see page 116

Default Paths for Data, see page 119

An optional simplified menu structure can be installed to reduce the number of top-level
menus in theMetaXpress Software. See Simplified Menu Structure on page 17.

Note: The concepts of users and groups as discussed in this section are specific to
custom hardware, and to drop-ins and toolbars settings for theMetaXpress Software.
They are NOT related in any way to configuring users and groups within the database.
For information on setting up users and groups within the database, see the
MDCStore High Content Data Management Solution Database Schema Installation
and Update Guide included on theMetaXpress Software Suite installation USB flash
drive.

Users and Groups in the Meta Imaging Series Administrator Software
TheMeta Imaging Series Administrator Software commands enable you to define and
configure settings for individual users and groups in theMetaXpress Software. There are two
modes for the Administrator:

Single-User mode, where the Administrator enables you to select hardware settings and
configure drop-ins and toolbars for groups that have already been created.

Multi-User mode, where you can create new groups, add users to different groups, and
define hardware settings for groups.

As a System Administrator, you can work within Multi-User mode to create groups and users
for your MetaXpress Software.
Your ImageXpress Nano System ships with a number of groups and hardware settings
predefined. The number of groups depends on the configuration of your system. Figure 6-1
shows theMultiple User Configurationwindow in theMeta Imaging Series Administrator
Software.

6
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Figure 6-1: Example of the Multiple User Configuration window
This example shows a system with the following groups defined:

IXM 20x-4x-10x-2x: This is the ImageXpress Nano System configured with a particular set
of objectives.

MX Analysis Only: This group is configured for analysis only to run theMetaXpress
Software with the instrument powered off.

To enable a group (that is, to use the hardware and software settings created for a group),
you must create users and assign them to the group.

Creating an Offline Version of the MetaXpress Software

Molecular Devices recommends creating an offline group for MetaXpress Software users.
This offline group does not include hardware settings and is useful for analysis of acquired
images. Since the offline group does not include hardware settings, it does not attempt to
establish communication with the other MetaXpress Software components. This lets the
application start faster, and lets you run the software without turning on any hardware.
Use the following procedure to create an offlineMetaXpress Software group in theMeta
Imaging Series Administrator Software:

Note: You must exit theMetaXpress Software before using theMeta Imaging Series
Administrator Software. The two programs cannot run at the same time.

1. Click Start > All Programs > MetaXpress > Meta Imaging Series Administrator.
Right-click on the application name and select Run as administratorwhen running the
Meta Imaging Series Administrator Software.

2. In theMeta Imaging Series Administrator Software, if the program opens in Single User
Configurationmode, click Enter Multi-User Mode.

3. Click Create Group.
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4. In the Create Group dialog, in theGroup Name field, type a group name, such as
MetaXpress Offline.

Figure 6-2: Create Group dialog

5. From the Application drop-down list, selectMetaXpress.

6. From theHardware Configuration drop-down list, select Offline.

7. From the Copy Settings From drop-down list, select [None].

8. Click Create to close the Create Group dialog and add the new group to theGroups list.

9. In theGroups list, click the new group.

10. In theUsers list, click a user that you want to add to the new offline group.

11. Click <<Add Users to add the user to the new group.

12. Continue to add users to the groups as needed.

Note: You must add at least one user to the new offline group to make it
available. Alternatively, you can return to Single Usermode, then the new group
works without adding users.

13. To avoid error messages, select the offline group, click Edit Group, then click Drop-
Ins/Toolbars and disable the plateacquire drop-in.

14. Click OK to exit theMeta Imaging Series Administrator Software.

Creating MetaXpress Software Group Icons and Adding Them to the
Windows Desktop

After creating theMetaXpress Offline group and adding users with the previous procedure,
use the Create Icons command to create icons for the new group. This command installs
shortcuts for any new groups to theMetaXpress folder on theWindows desktop. These
shortcuts can then be copied directly to theWindows desktop. This lets users choose which
software configuration to start from the desktop.
Use the following procedure to create and add group icons to theWindows desktop:

1. Click Start > Programs > MetaXpress and then right-clickMeta Imaging Series
Administrator and select Run as administrator to start theMetaXpress Meta Imaging
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Series Administrator Software.

2. Click Create Icons.

3. Click OK to exit theMeta Imaging Series Administrator Software.

4. Double-click theMetaXpress 6.x shortcut on your desktop.

5. In theMetaXpress 6.x folder, confirm that a shortcut for the group that was created in
Creating an Offline Version of theMetaXpress Software on page 114 is listed.

6. Right-click the shortcut (for example,MetaXpress Offline), and then select Send To >
Desktop to create the shortcut on the desktop.

7. Continue to add shortcuts to the desktop, as needed.

8. Double-click the new desktop shortcut to open that instance of the software.

Custom Toolbars and Taskbars
After you have groups configured, you can create or modify custom toolbars and taskbars to
include specific combinations of tools and commands.

Customizing Toolbars

With the Configure Drop-ins/Toolbars command, you can add menu commands to
toolbars, move commands from one tool bar to another, and add journals to or remove
journals from toolbars.
Use the following procedure to customize the toolbars:

1. Click Start > Programs > MetaXpress and then right-clickMeta Imaging Series
Administrator and select Run as administrator to start theMetaXpress Meta Imaging
Series Administrator Software.

2. Select a Group Name fromMeta Imaging Series Administrator > List of Groups.

3. Depending on which User Mode you are in:

a. Single User Mode: Click Drop-ins/Toolbars.

b. Multi-User Mode: In the Edit Group dialog, click Drop-ins/Toolbars.

4. In the Configure Drop-ins/Toolbars dialog, click the Toolbars tab.

5. If it is selected, deselect theUse default toolbars check box.

6. In the Commands section, select the item you want to add to the toolbar:

SelectMenus to add menu commands to toolbars.

Select Toolbars to add toolbar commands to other toolbars.

Select Journals to add journals to any toolbar or to create new Journal toolbars.
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7. To add any command to a toolbar, drag the command from the left pane to the
appropriate toolbar folder in the right pane.

Note: You can use the CTRL or SHIFT keys in combination with a mouse-click to
select multiple commands, and then drag the commands to the appropriate
toolbar folder.

8. Click OKwhen finished.

9. Click Yes in themessage to confirm that you want the users in the group to use the
modified configuration.

10. Click OK to close the Edit Groups dialog.

11. Click OK to exit theMeta Imaging Series Administrator Software.

Themodified toolbars will be available the next time you start the corresponding version of
theMetaXpress Software.

Creating Taskbars

You can create custom taskbars directly in theMetaXpress Software. Taskbars are a
convenient way to access frequently used commands and journals. Each taskbar can have
up to 48 buttons in a configuration of rows and columns of your choosing. You can mix and
match journals, commands, or other taskbars within the same taskbar. Molecular Devices
recommends creating taskbars that combine commands and journals specific to your
experiments.

Tip: When using taskbars, to show the last used taskbar, press F4.

To create and load a taskbar, use the following procedure:

1. Start theMetaXpress Software.

2. Click Journal > Taskbars > Create Taskbar.
In the simplified menu, click Control > Journal > Taskbars > Create Taskbar.

3. When the Taskbar Editor dialog and New Taskbarwindow open, position them so that
you can see both the dialog and the window at the same time.

4. Define the number of rows and columns for the taskbar by dragging the edges of the
New Taskbarwindow until the desired number of rows and columns appear in the
window.

5. Define the width of all the buttons in the taskbar by dragging the right or left edge of the
active button until the buttons are the desired width.
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6. Under Category, select the type of item you want to add to the taskbar:

Select Function to add a software function to the taskbar.

Select Journal to add a journal to the taskbar.

Select Taskbar to add a link to another taskbar to the taskbar.

Note: If you select Journal or Taskbar as the Category, the directory names are
displayed in square brackets in the list. Double-click a directory name to display
the appropriate files in that directory, or double-click the double period [..] to go
up one level in the directory structure.

7. When you have located the item you want to add to the taskbar, double-click its entry in
the list to add it to the active button in the taskbar as shown in Figure 6-3.

Figure 6-3: Adding a function to a taskbar

8. Continue to add items to the taskbar by clicking a blank button, selecting the Category,
and double-clicking the entry in the list.

9. If necessary, click Undo to undo the last action or click Clear Button to clear an item from
the active button.

10. To give the task bar a descriptive name, click Rename Taskbar.

11. In the Rename Taskbar dialog, in the Taskbar Title field, type the new name.

12. Click OK.
In theNew Taskbarwindow, the new name becomes the title of the window.

13. In the Taskbar Editor dialog, click Save.
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14. In the Save As dialog, type a name for the taskbar file and navigate to the appropriate
drive and folder, if necessary.

15. Click Save.

16. In the Taskbar Editor dialog, click Close.

17. To use the new taskbar (or a different taskbar) immediately, click Journal > Taskbars >
Load Taskbar.

18. In the Select a Taskbar dialog, navigate to the appropriate drive and folder and select
the desired taskbar file.

19. Click Open.

Default Paths for Data
The Configure Default Paths command in theMetaXpress Software is used to change the
default file paths for each group or user. You can modify these paths so that the users on the
system have their own dedicated data folders. These folders contain log files, calibration
settings, and other data that can be unique to each user. Molecular Devices recommends
changing the following default paths:

Default Data Paths: Your system computer has a dedicated hard drive partition for data.
The default data file paths for each user should all point to this data drive. For example:
D:\Data\Username.
The following data file types should have their file paths changed to point to the data
drive:

Log files

Memory lists

Calibrations

Illumination Settings

Magnification Settings

Default HTS State Path: TheMetaXpress Software protocol file path should also point to
the data drive. For example: D:\MX\HTSSTATE\.

Note: TheMetaXpress Software protocol is saved to the database by default.

Note: Molecular Devices recommends making monthly backups of the Data and HTS
State files.

To edit the default data paths for a group, use the following procedure:

1. Start theMetaXpress Software.

2. Click Edit > Configure Default Paths.
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3. In the Configure Default Paths dialog, select the item with the default file path you want
to modify.

Figure 6-4: Configure Default Paths dialog

4. ClickModify.

5. In the Browse for Folder dialog, select the folder that you want to use for the new
default path, or click New to create a new folder.

6. Click OK.

7. In the Configure Default Paths dialog, click OK to apply the new default path and close
the dialog.
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Chapter 7: Optional Expansion Solutions

Users of an can upgrade to include the following optional expansion solutions:

Environmental Control Options, see page 121

Transmitted Light Options, see page 134

Contact your Molecular Devices representative to discuss adding appropriate optional
expansion solutions to your system.
For systems factory-equipped with any of these expansion solution options, the following
sections provide operating procedures for each option.

Environmental Control Options
The ImageXpress Environmental Control option is designed to maintain an environment for
living cells to enablemulti-day, live-cell, timelapse imaging. Temperature, carbon dioxide,
and humidity can all bemaintained within the sample plate so that cells can be kept alive for
many days, growing at a rate comparable to that expected in a standard cell culture
incubator.
The ImageXpress Environmental Control option can be installed together with the
ImageXpress Transmitted Light option.
See also:

Transmitted Light Options, see page 134

Operational information is included for the following:

Environmental Control Hardware, see page 121

Setting Up Environmental Control, see page 125

Environmental Control Software

Cleaning Environmental Control Components, see page 133

Environmental Control Hardware

The ImageXpress Environmental Control option consists of a sealing ring on top of the
sample plate and a top door above the plate that together forms a small, sealed volume.
Humidified carbon dioxide is sourced into this small volume to form the required
environment above the plate. Temperature is controlled within the upper half of the
instrument.
The ImageXpress Environmental Control option consists of the following hardware
subsystems:

Temperature control within the upper half of the base instrument. Warm air is provided
from the ImageXpress Systems Power and Options Controller through an air hose.
Feedback from temperature sensors installed near the platemaintains the temperature.

7
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The temperature inside themicroplate chamber can bemaintained at 8°C above
ambient to 40°C.

Carbon dioxide is provided from a customer-supplied tank of pre-mixed 5% CO2 and 95%
air. The tank regulator must be set between 15 PSI and 20 PSI. The ImageXpress Systems
Power and Options Controller controls the flow to the space above the plate, maintained
by the live-cell sealing ring. If a plate is ejected and loaded, the system does a purge cycle
automatically.

Humidity is passively provided by bubbling the carbon dioxide through a water
reservoir, minimizing evaporation from the sample plate over the duration of a
timelapse experiment.

Items Included in the Installation

The following hardware components are included in an ImageXpress Environmental Control
option installation:

ImageXpress Systems Power and Options Controller. See Figure 7-1.

Warm air hose and carbon dioxide tubing. See Figure 7-2 and Figure 7-3.

Temperature sensors. To ensure accurate readings, the sensors are located near the
sample plate.

Water reservoir. See Figure 7-4.

Live-cell sealing ring. Compatible with 96-well and 384-well standard height plates. The
standard height for these plates is 14.35 mm ± 0.25 mm (0.5650 inches ± 0.0098 inches).
See Figure 7-5.
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Figure 7-1: ImageXpress Systems Power and Options Controller used for the
ImageXpress Nano System

Figure 7-2: Environment Control option connections on the back of the
ImageXpress Systems Power and Options Controller used for the
ImageXpress Nano System
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Figure 7-3: Environment Control option warm air hose and carbon dioxide tubing on the
back of the ImageXpress Nano System

Figure 7-4: Environment Control option water reservoir

Figure 7-5: Environment Control option live-cell sealing ring
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Items to be Provided by the Customer

The customer must provide the following items for the ImageXpress Environmental Control
option installation:

A tank of pre-mixed 5% CO2 and 95% air.

The regulator, fittings, and tubing required to deliver 15 to 20 PSI carbon dioxide from
the tank to the ImageXpress Systems Power and Options Controller for the
ImageXpress Nano System.

Microplates with standard ANSI height. Most 96-well and 384-well plates are standard
height. The standard height for these plates is: 14.35 mm ± 0.25 mm (0.5650 inches ±
0.0098 inches).

Deionized water to maintain humidity.

Setting Up Environmental Control

AMolecular Devices FSE (Field Service Engineer) installs the ImageXpress Environmental
Control option. After installation, environmental control can be set up for experiments.

Setting the Temperature

The temperature controller is calibrated before the instrument ships from the factory. Use
the external temperature controller to set the temperature that you want the environmental
enclosure to maintain.
To set the temperature:

1. On the front of the , view the current sample plate temperature.

Figure 7-6: Sample Plate Temperature control interface

2. To view the temperature set point, press«.

3. To increase the temperature set point, press« and5.

4. To decrease the temperature set point, press« and6.

After you release«, the current temperature in the chamber is displayed.
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Setting Up the Water Reservoir

The purpose of the water reservoir is to add humidity to the air flow supplied to the
environmental enclosure.
Use the following procedure to fill the water reservoir outside of the instrument.
Alternatively, to fill the water reservoir inside of the instrument, see Filling theWater
Reservoir Inside the Instrument on page 129.
Requirements:

Phillips screwdriver

250 mL Deionized Water (preferably sterilized)

To fill the water reservoir outside the instrument:

1. In theMetaXpress Software, click Screening > Plate Acquisition Setup > Eject Plate to
open the top door of the instrument.
In the Simplified Menu Structure, click Screening >Acquisition Setup > Eject Plate to
open the top door of the instrument.

2. Exit theMetaXpress Software and turn off the instrument at themain power switch,
which is located on the external power supply.

3. Remove the top access panel surrounding the top door (Figure 7-7), and for more access.

Figure 7-7: Top access panel around the top door on and off



Chapter 7: Optional Expansion Solutions

5058342 B 127

4. Locate the water reservoir through the top opening.

Item Description

1 Luer Locks

2 Water Sensors Wires

3 Water Sensor

Table 7-1: Environment Control Option Water Reservoir

5. Disconnect the CO2/air tubing from the luer locks on both side of the water reservoir.

6. Unplug the sensors from the green luer lock side of the water reservoir and remove the
water reservoir from the instrument.

7. Use a Phillips screwdriver to loosen the four screws securing the reservoir lid.

8. Remove the lid.

9. Fill the reservoir with deionized water to theMax Fill Line (250 mL).

10. Replace the lid, tighten the screws, and then place the reservoir back in the instrument.

11. Reconnect the wires to the sensors on the green luer lock side.

Note: The color of the sensor wire is irrelevant when connecting to the sensor
socket. Either color of sensor wire can connect to either sensor socket.
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Figure 7-8: Water level sensor wire sockets

Figure 7-9: Water level sensor wires inside the instrument

12. Reconnect the CO2/air tubing to the luer locks on both sides of the water reservoir.

13. Replace the top access panel surrounding the top door and . See Figure 7-7.

14. Start the instrument.

15. In theMetaXpress Software, click Screening > Plate Acquisition Setup > Load Plate to
close the top door of the instrument.
In the Simplified Menu Structure, click Screening > Acquisition Setup > Load Plate to
close the top door of the instrument.
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Filling the Water Reservoir Inside the Instrument
Use the following procedure to fill the water reservoir inside the instrument.
Requirements:

Syringe

250 mL Deionized Water (preferably sterilized)

To fill the water reservoir inside the instrument:

1. In theMetaXpress Software, click Screening > Plate Acquisition Setup > Eject Plate to
open the top door of the instrument.
In the Simplified Menu Structure, click Screening >Acquisition Setup > Eject Plate to
open the top door of the instrument.

2. Exit theMetaXpress Software and turn off the instrument at themain power switch,
which is located on the external power supply.

3. Remove the top access panel surrounding the top door (Figure 7-10), and for more
access.

Figure 7-10: Access panel around the top door on and off

4. Locate the water reservoir through the top opening.

Figure 7-11: ImageXpress Environmental Control option water reservoir

5. for more access.
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6. Disconnect the CO2/air tubing from the green luer lock on the side of the water reservoir.

7. Insert a syringe filled with deionized water through the green luer lock.

8. Dispense the deionized water from the syringe into the water reservoir until the water
reaches theMax Fill Line (250 mL).

9. Remove the syringe from the green luer lock.

10. Reconnect the CO2/air tubing to the green luer lock.

11. Replace the top access panel surrounding the top door and . See Figure 7-10.

12. Start the instrument.

13. In theMetaXpress Software, click Screening > Plate Acquisition Setup > Load Plate to
close the top door of the instrument.
In the Simplified Menu Structure, click Screening > Acquisition Setup > Load Plate to
close the top door of the instrument.

Setting Up the Carbon Dioxide Tank

A pre-mixed CO2 tank with a regulator must be set up and connected to the CO2 inlet on the
Options Controller. The CO2Options Controller then controls the flow rate of CO2 delivered
to the water reservoir within the environmental enclosure.
Before you begin, make sure the water reservoir is set up. See Setting Up theWater
Reservoir on page 126.
To set up the CO2:

1. Connect the regulator to the CO2 tank.

2. Connect the tubing from the pre-mixed CO2 tank regulator to the .

3. Verify that the tubing from the to the instrument is connected.

4. Turn on the CO2 regulator to approximately 15 PSI to 20 PSI.

5. From the top of the instrument, lift the top access panel surrounding the top door and
remove it. Keep the top door of the instrument closed.

Figure 7-12: Top access panel around the top door on and off

6. Verify that there is a steady flow of bubbles in the water reservoir.

7. Replace the top access panel surrounding the top door.
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8. Check the environmental control settings to verify that the CO2 pressure is OK. See
Environmental Control Software.

After setting up the carbon dioxide
Load an unlidded plate with the live-cell sealing ring on top. If there are concerns about
contamination, a breathable seal can be used over the top of the plate. See Loading the
Sample Plate on page 131.

Note: Before you do imaging experiments, wait for the system and plate to reach
equilibrium. Allow at least two hours for the system and 30 minutes for the plate.
Because focus settings and offsets change with temperature, you might need to
optimize them after the system and plate have reached equilibrium.

Loading the Sample Plate

You must use the live-cell sealing ring to maintain the CO2 flow to the sample plate. The
sealing ring helps to contain the inputted air directly over the cells and maintains the proper
CO2 and temperature levels.

WARNING! BIOHAZARD. Wear gloves when handling sample plates.

Note: To ensure that it is at the proper temperature, before you load the sample
plate, make sure that the live-cell sealing ring is in the system or in the incubator.

To load the sample plate:

1. In theMetaXpress Software, click Screening > Plate Acquisition Setup > Eject Plate to
open the top door of the instrument.
In the Simplified Menu Structure, click Screening > Acquisition Setup > Eject Plate to
open the top door of the instrument.

2. Insert the sample plate into the stage and then remove the lid from the plate. If there are
concerns about contamination, a breathable seal can be used over the top of the plate.
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3. Place the live-cell sealing ring directly on top of the plate, making sure that it fits securely
onto the plate.

Figure 7-13: Environment Control option live-cell sealing ring

4. In theMetaXpress Software, click Screening > Plate Acquisition Setup > Load Plate to
close the top door of the instrument.
In the Simplified Menu Structure, click Screening > Acquisition Setup > Load Plate to
close the top door of the instrument.

Note: Temperature fluctuations in the plate and its surroundings cause the plate
and its cells to shift in X, Y, and Z direction. To minimize these temperature
fluctuations, take the following precautions.
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Before you run an experiment

Check the water reservoir level. Refill as needed.

Check the CO2 supply. Refill as needed.

Allow the instrument to warm up for at least two hours. The current temperature in the
chamber is displayed on the front of the controller.

Make sure the plate sealing ring is at 37°C before use, either by keeping it inside the
instrument or inside an incubator. Incorrect sealing-ring temperature can cause
temperature fluctuation.

Wait 30minutes to 1 hour for the plate to reach equilibrium. You can use a journal to set
this waiting period.

If there is interstitial space between wells, pipette deionized water or media into these
areas. This helps to increase the thermal mass of the plate and reduces overall
evaporation.

Fill all unused wells with deionized water or buffer.

Note: Due to the changes in Z-height over time, you might need to adjust the
plate focus parameters in theMetaXpress Software occasionally. To do so, open
theMetaXpress Software, and then click Screening > Plate Acquisition Setup >
Plate tab > Edit Plate Bottom Settings. Increase the adjacent well max variation
to accommodate the added Z-height variation introduced by the fluctuation of
temperature.

When setting laser autofocus options, make sure that the instrument and plate
temperatures are at equilibrium. Room-temperature laser autofocus settings are
not ideal when the system is used at higher temperatures.

Cleaning Environmental Control Components

It is important to regularly clean the environmental enclosure, including specific
environmental components. Components can come in contact with biological, chemical, and
toxic agents. Therefore, all cleaning procedures should be handled with care. Molecular
Devices recommends that you wear powder-free gloves at all times when you access the
internal components of the enclosure. For additional information about cleaning the system,
seeMaintenance on page 141.

CAUTION! Never use an autoclave to clean any of the instrument components.

Environmental Control components to be cleaned include:

Cleaning Carbon Dioxide Tubing

Cleaning theWater Reservoir
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Transmitted Light Options
Operational information is included for the following:

Transmitted Light Hardware on page 134

Setting up Koehler Illumination on page 136

Replacing the Transmitted Light Bulb on page 138

Transmitted Light Hardware

The ImageXpress Transmitted Light option consists of the following hardware components.

White light lamp (halogen). The software controls the lamp power.
The halogen lamp has a limited life and can be replaced. See Replacing the Transmitted
Light Bulb on page 138.

Transmitted Light shutter. Controlled by the software. The shutter protects the sample
from the transmitted light when not imaging. The shutter windowmaintains the
environment of the sample. See Figure 7-16.

Hinge.Increases access to the plate if necessary. See Figure 7-17.

Figure 7-14: ImageXpress Nano System with the Transmitted Light option
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Figure 7-15: ImageXpress System with Transmitted Light option (detailed view)

Figure 7-16: Transmitted Light shutter

Figure 7-17: Hinge-release knob and hinge
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Item Description

1 Hinge-release knob

2 Hinge

3 Hinge-release knob

4 Assembly tipped back with hinge-release knob unscrewed

Setting up Koehler Illumination

To ensure high-quality illumination with brightfield or phase contrast imaging, set up the
Transmitted Light option for Koehler illumination. Do this alignment anytime there is
concern about the quality of the transmitted light images, or when changing plate type or
slide type. Since the objectives are parfocal, repeating this procedure after switching
objectives is unnecessary.

Item Description

1 Field Aperture Diaphragm Control (* this control can be located here on older Transmitted
Light models)

2 Condenser Focus Control

3 Condenser Adjustment Screws (Aperture Lateral Adjustment Control)

4 Condenser Turret

5 Field Stop Slider (Condenser Aperture Diaphragm Control)

Table 7-2: ImageXpress Transmitted Light option overview

To set up the ImageXpress Transmitted Light option for Koehler Illumination

1. Load the sample (multi-well plate or slide).

2. Select a lowmagnification objective such as the 10x Plan Fluor or a 4x objective.

3. Rotate the condenser turret (4) so that the A position is selected (at the front). Open the
condenser aperture diaphragm by moving the field stop slider (5) above the A to the
right.
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4. In theMetaXpress Software, click Screening > Plate Acquisition Setup.
In the simplified menu, click Screening > Acquisition Setup.

5. In the Plate Acquisition Setup dialog, move the stage to a well or slide area where there
is visible sample.

6. Select one of the available Transmitted Light illumination settings.

7. Use the laser-based autofocus, image-based autofocus, or live mode to focus on the
sample.

8. Click Start Live.

9. Close the field aperture diaphragm (1)most of the way by moving the lever left.

10. Adjust the condenser height with the condenser focus control (2) until a bright polygon
surrounded by sharp dark edges is visible.

Figure 7-18: Condenser height focus adjustment comparison

11. If you cannot detect sharp edges, open the field aperture diaphragm (1) further, and try
adjusting the condenser height again.

12. Center the white polygon with the condenser adjustment screws (3), also known as field
diaphragm adjustment screws.

13. Open the field aperture diaphragm (1) by moving the lever right, or up if you have the
older model (1*), until the whole field is illuminated and the dark edges are just outside
of the field of view. Opening this too far can increase glare in the images.

14. Close the condenser aperture diaphragm slightly by moving the field stop slider (5)
above the A to the left, to optimize the sharpness and contrast of the transmitted light
image.

15. Click Stop Live.
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16. Click Focus to confirm proper illumination. If you see dark edges in your field of view,
repeat step 12.

Figure 7-19: Adjustment of the Field Aperture Diaphragm Comparison
The adjustment is now complete.

Replacing the Transmitted Light Bulb

The ImageXpress Transmitted Light option uses a replaceable 12 volt halogen light bulb. See
Replacement Parts and Optional Extras on page 163.
To replace the light bulb:

1. Unplug the power cord from the controller box.

2. Remove the set screw that secures the cover on top of the tower using a 3 mm hex
wrench.

Figure 7-20: Set screw location
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3. Remove cover by lifting it upward.

Figure 7-21: Cover removal

4. Face the light source from the rear and identify the bulb and the lever.

Figure 7-22: Bulb and lever

5. Put on cotton gloves to handle the bulb.

CAUTION! Never touch the bulb with bare hands.



ImageXpress Nano System with MetaXpress Software User Guide

140 5058342 B

6. Press the lever towards the right and pull the bulb out towards the left. Make note of the
location where the pin of the bulb was inserted.

Figure 7-23: Press lever and remove bulb

7. Insert the new bulb with the correct rating and specifications.

8. Replace cover and secure it with the set screw.

9. Plug in the controller box.
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Chapter 8: Maintenance

Do only themaintenance described in this guide. Maintenance procedures other than those
specified in this guidemust be done by qualified Molecular Devices personnel only. See
Obtaining Support on page 149.
Before you operate the instrument or do maintenance operations, make sure you are
familiar with the safety information in this guide. See Safety Information on page 7.

Safety Precautions
To avoid personal injury or damage to the equipment during service or maintenance
procedures, observe the following precautions.

Some procedures require that the power supply for the instrument is turned OFF and
that the power cable is unplugged before doing the service or maintenance procedure.

Some procedures require that you disconnect the USB connection to the hardware
server (host) PC, and turn off any attached peripherals.

Access only the user-serviceable components inside the enclosure as described in the
procedure. Avoid contact with other components as they can be damaged or knocked
out of alignment.

CAUTION! Do not touch the autofocus laser.

To prevent dust from collecting inside the instrument, keep all access doors closed
unless you are doing maintenance tasks.

Ensure that all components and access doors are closed before starting the instrument.

The following topics describemaintenance procedures that can be done by users to ensure
optimal operation of the instrument.

PreventiveMaintenance, see page 142

Clean the Instrument, see page 142

Light SourceMaintenance, see page 142

ObjectiveMaintenance, see page 143

WARNING! Service or maintenance procedures other than those specified in this
guide can be done only by Molecular Devices qualified personnel. When service is
required, contact Molecular Devices technical support.

8
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Preventive Maintenance
To ensure optimal operation of the instrument, do the following preventivemaintenance
procedures as necessary:

Wipe off visible dust from exterior surfaces with a lint-free cloth to avoid dust build up on
the instrument.

Wipe up all spills immediately.

Follow applicable decontamination procedures as instructed by your laboratory safety
officer.

Respond as required to all error messages displayed by the software.

Power off the instrument when not in use.

Clean the Instrument

WARNING! BIOHAZARD. Always wear gloves when operating the instrument
and during cleaning procedures that could involve contact with either hazardous
or biohazardous materials or fluids.

Always turn the power switch off and disconnect the power cord from themain power
source before using liquids to clean the instrument.

Wipe up all spills immediately.

Do not use any cleaning agents other than those recommended in this procedure
without first contacting Molecular Devices Technical Support. See Obtaining Support on
page 149.

Do not use ultraviolet light for sterilization, as this can damage plastic components.

Do not use any organic solvents.

Do not pour or squirt water or alcohol directly onto the instrument, to prevent
damaging internal components.

Light Source Maintenance
The ImageXpress Nano System is equipped with an external light source connected to the
instrument with a light guide.

CAUTION! Do not fold or crimp the light guide. The light quality will be diminished and
the fiber optics can break.

The external light source for the ImageXpress Nano System is a solid-state light source that
has a rated lifetime ofmore than 10,000 hours. There are no user-replaceable parts in this
light source. When the light source needs replacing, contact Molecular Devices. See
Obtaining Support on page 149.
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Objective Maintenance
Objective lenses can be cleaned while inside the instrument, or you can remove the
objective lenses from the instrument for cleaning. .
You can identify themagnification of the objectives installed inside your instrument by the
following color bands:

Yellow—10x

Red—4x

Green—20x

Light blue—40x

Dark blue—60x

Correct Objective Placement
By default Molecular Devices configures your instrument with any objective with a correction
collar installed in the outer positions 1 and 4. The outer positions provide easier access
through one of the side panels for adjusting the correction collar.

Tip: Objectives must be replaced in their original positions. Molecular Devices
recommends removing and maintaining only one objective at a time.

Note: Molecular Devices recommends that you leave the reference objective in place
and replace only the other objectives. The reference objective is typically a 10x
objective and is typically installed in position 3.

Adjusting the Spherical-Aberration Correction Collar on ELWD
Objectives

The ELWD (extra long working distance) Nikon objectives that can be supplied with the have
adjustable correction collars, that minimize spherical aberration in the image of the
specimen. The collars have a range of 0 mm to 2 mm correction, and changing this setting
adjusts the distances between components inside the objective barrel. Image quality and
resolution are very much dependent on properly setting these collars.

Note: Some other objectives (non-ELWD) can also have correction collars. The range
can vary depending on the objective.

The settings to be used depend on the thickness of themicroplate well or slide on which the
specimen is mounted. In general, set the correction collar for the physical thickness of the
plate or slide that you are imaging. The physical thickness can be determined in one of the
following ways:
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Get the plate specifications from the platemanufacturer.

Break a spare plate and use calipers to measure the thickness.

Measure the optical thickness with the laser autofocus and multiply it by the refractive
index of 1.59 for polystyrene or 1.52 for glass.

After you have determined the thickness of your plate or slide, you can adjust the correction
collar.

CAUTION! If the thickness of the intended plate, slide, or coverslip is out of the range
of the correction collar, it should not be used with the selected objective.

Before adjusting the correction collar on an objective, read and follow the Safety Precautions
on page 141.

1. Start theMetaXpress Software and log in to the database.

2. In theMetaXpress Software on the IXM taskbar, click Adjust Correction Collar to access
the specific objective.

3. If the objective is in one of the center positions, access it from the top.
When prompted by the software, remove the plate or slide holder, and then click
Continue.

4. Locate the correction collar on the objective that you want to adjust.
If needed, loosen or remove the objective to locate the correction collar.

Tip: You might need to use a flashlight to view themarkings for the graduated
scale on the barrel and its current setting.

5. Rotate the correction collar to its new setting. If needed, replace or tighten the objective.

6. If you accessed the objective from the side, close the upper, hinged side panel door.

7. Click Continue.

8. If you accessed the objective from the top, then replace the plate or slide holder when
prompted, and then click Continue.

9. Test the correction collar setting by examining the image quality of acquired images.
If the quality has degraded, re-adjust the correction collar by repeating this procedure.
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Updating Shading Correction Settings-Legacy

Note: This procedure is required if Legacy Correction setting is selected as the
Shading Correctionmethod for one or more acquisition wavelengths.

Shading correction files are needed for each objective and filter set, and must be generated
whenever an objective or filter is replaced or added to the system, or whenever the light
guide replaced.

Note: For shading correction images to be used during Plate Acquisition, the Legacy
Correction setting must be selected in the Shading Correction field of an individual
wavelength tab in the Plate Acquisition Setup dialog.

Requirements
Shading Plates
To generate the shading correction files, you need a shading correction plate that is
appropriate for the filter set you are using. Shading correction plates are part of the included
accessory kit.
Remove the paper backing from each plate before use. Handle the plates by the edges to
avoid getting fingerprints on the imaging surface. Never use alcohol or other solvents to
clean the plates. You can use compressed air to remove dust from the plates.
System Maintenance Taskbar
To run the shading correction journal, you need the System Maintenance Taskbar.jtb that is
part of theMain Taskbar.jtb. To determine if this taskbar is installed on your computer, do
the following procedure:

1. Start theMetaXpress Software and log in to the database.

2. Click Journal > Taskbars > Load Taskbar.
In the simplified menu, click Control > Journal > Taskbars > Load Taskbar.

3. In the Select a Taskbar dialog, navigate to the Taskbars folder in theMetaXpress
Software installation folder.
The default installation is in C:\MX6\Taskbars.

4. Select the System Maintenance Taskbar.jtb file.
If the System Maintenance Taskbar.jtb file does not exist on your computer, see
Importing theMain Taskbar Journal Suite on page 146.

5. Click Open to load the taskbar.

After you havemet all the requirements, you can update the shading correction settings. See
Running the Shading Correction Journal from theMain Taskbar on page 149.
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Importing the Main Taskbar Journal Suite

The IXM Taskbar is a collection of tools intended to enhance and streamline common
imaging workflows.
Do the following procedure only if theMain Taskbar is not installed on your computer. If the
Main Taskbar is installed, see Running the Shading Correction Journal from theMain
Taskbar on page 149.

Tip: If you plan to create additional groups (or configurations) in theMeta Imaging
Series Administrator Software, do this procedure before creating the additional
groups. You can then create the groups using the option to copy settings from
existing groups.

1. Contact Technical Support to get the journal suite file IXMTaskbar_v#.jzp, where # is the
current version of the software. See Obtaining Support on page 149.

2. Download the IXM_Taskbar_v#.jzp file to the workstation computer.

3. Start the instrument.

4. Start theMetaXpress Software and log in to the database.

5. Click Journal > Import Journal Suite.
In the simplified menu, click Control > Journal > Import Journal Suite.

Figure 8-1: Import Journal Suite dialog

6. In the Import Journal Suite dialog, click Select Journal Suite and locate the IXM_
Taskbar_v#.jzp file.
The path to the journal suite file is displayed at the top of the Import Journal Suite
dialog.
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7. Click Select Import Location and browse to the Taskbars folder within theMetaXpress
installation directory.
The default installation is in C:\MX6\Taskbars. If it is missing, create the Taskbars folder.

Tip: To determine the correct installation folder, right-click theMetaXpress
Software icon on you desktop and then click Open file location.

8. Select the Taskbars folder and click OK.

9. In the Import journal Suite dialog, click Import.

10. Click Closewhen done.

Note: There is no visual confirmation that the import is complete.

11. Click Journal > Taskbars > Load Taskbar.
In the simplified menu, click Control > Journal > Taskbars > Load Taskbar.

12. In the Select a Taskbar dialog, navigate to the Taskbars folder in theMetaXpress
Software installation folder.
The default installation is in C:\MX6\Taskbars.

13. Select theMain Taskbar.JTB file and then click Open.

Figure 8-2: The Main Taskbar dialog

14. In theMain Taskbar, click Run IXM Taskbar Installer.
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15. In theMetaXpress Directory, follow the prompts in the subsequent dialogs to confirm
that the current version of theMetaXpress Software is installed in the correct directory.

Figure 8-3: IXM Taskbar Installer

Note: The check boxes that are pre-selected in the IXM Taskbar Installer dialog
are the recommended tasks for your configuration.

16. In the IXM Taskbar Installer dialog, click OK.

17. If the Select Configurations dialog appears, select the current group or All groups, and
then click OK.
Molecular Devices recommends that you select All groups.

18. If the Select Users dialog appears, select the current user or All users, and then click OK.
Molecular Devices recommends that you select All users.

19. In the Select directory for default paths dialog, select themain MetaXpress installation
directory.
The default installation is in C:\MX6.

20. Click OK.

21. In the Configure Menu dialog, select to Install or Uninstall the simplified menu.
Molecular Devices recommends using the simplified menu. See Simplified Menu
Structure on page 17.

22. Click OK.

23. Exit and restart theMetaXpress Software.

To run the shading correction journal, see Running the Shading Correction Journal from the
Main Taskbar on page 149.
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Running the Shading Correction Journal from the Main Taskbar

1. From theMain taskbar, select System Maintenance and then click Set up Shading
Correction.

2. Follow the prompts to focus on the plates and create shading correction files.

Tip: To show or hide the taskbar that was most recently used, press F4 on your
keyboard.

Turning off the Status Indicator Lights
The status light on the front of the ImageXpress Nano System illuminate with colors that
provide information about the instrument status.
If required, you can turn off the status indicator lights in theMetaXpress Software from the
Devices >Device Control > Other tab, or in the simplified menu Control > Devices >Device
Control > Other tab, and deselect the Enable Microscope LED check box.

Obtaining Support
Molecular Devices is a leading worldwidemanufacturer and distributor of analytical
instrumentation, software, and reagents. We are committed to the quality of our products
and to fully supporting our customers with the highest possible level of technical service.
Our support website, www.moleculardevices.com/support, has a link to the Knowledge Base
with technical notes, software upgrades, safety data sheets, and other resources. If you do
not find the answers you seek, follow the links to the Technical Support Service Request
Form to send an email to our technical support representatives.
You can contact your local representative or contact Molecular Devices Technical Support at
800-635-5577 (North America only) or +1 408-747-1700. In Europe, call +44 (0) 118 944 8000.
To find regional support contact information, visit www.moleculardevices.com/contact.
Molecular Devices provides a wide range of support:

Documentation: Check the guides that are included on the installation media and the
Help that is available within theMetaXpress Software. Help for an active dialog can be
accessed by pressing F1 on your keyboard.

Online Knowledge Base: The Knowledge Base has links to technical notes, software
upgrades, newsletters, user guides, and other resources. Visit theMolecular Devices
Support website at www.moleculardevices.com/support and follow the links to the
knowledge base.

http://www.moleculardevices.com/support
http://www.moleculardevices.com/contact
http://www.moleculardevices.com/support
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Technical Support:
Online: Visit www.moleculardevices.com/support and follow the links in the knowledge
base to the Technical Support Request Form to send an email to a group of experienced
Technical Support representatives.
Please have the system serial number, software version number, and the name of the
system owner available.
To find your serial number:

In theMetaXpress Software, click Help > About MetaXpress. The About dialog displays
your system ID number.

For all systems, the serial number is located on the back connector panel of your
instrument.

Figure 8-4: Serial Number location on the back of ImageXpress Nano

Gathering Support Information

If you need to contact Molecular Devices for support, it is very important to have the
following information available to help the Technical Support personnel troubleshoot the
problem you are experiencing:

The steps that led up to the occurrence of the problem

The settings of any dialogs used when the problem occurred

The text of any error messages

You should also collect the following information from your system whenever reporting
software problems:

Copy of the Plate Acquisition Settings file: By default, the plate acquisition settings file
is saved to the database. To save the settings to a file, go to the Experiment tab of the
Plate Acquisition Setup dialog, click Save Protocol, and then select Save to file rather
than to the database. The settings file is then saved to the C:\MX6\HTSSTATE folder by

http://www.moleculardevices.com/support
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default.

Journal files: If you were running a journal when the problem occurred, include copies
of the journal files that you were using. By default, journal files are saved in the
C:\MX6\app\mmproc\journals folder. If you are running journals through the review
plate data tab, then the journals are saved in c:\analysis and c:\assay.

System Information Report: This report contains information about many system
settings and the release levels of all the.dll files in your currently installed MetaXpress
Software. For information on how to create a System Information report to email to
Molecular Devices, see Creating a System Information Report on page 153.

Logging AxoTrace Software Messages to a .txt File

The AxoTrace Software tracks the hardware status of the ImageXpress Nano System and logs
all the hardware activities of the system. If an error occurs downstream of the initial cause,
the AxoTrace Software provides a log that Molecular Devices Technical Support can use to
trace the error back to the original cause and pinpoint the problem. Use the following
procedure if a reproducible hardware error occurs. Follow the AxoTrace Software setup
procedure and record the steps that lead to the error. If the error results in the instrument
not starting up, not responding, or the error cannot be reproduced, contact Molecular
Devices Technical Support immediately.
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To log AxoTracemessages to a .txt file:

1. Open theMetaXpress Software and the AxoTrace Software starts automatically.
The AxoTrace Software icon appears in theWindows taskbar.

Figure 8-5: AxoTrace Software icon in the Windows taskbar

2. Exit theMetaXpress Software.

3. Double-click the AxoTrace Software icon in theWindows taskbar.

4. In the AxoTrace window, click Options and make sure that the Time prefix option is
selected.

Figure 8-6: AxoTrace Software Options menu

5. Click File > Exit to close the AxoTrace window.

6. Start theMetaXpress Software.

7. Turn off the ImageXpress Nano System and then turn it back on.
The light source can remain on during this step.

8. Reproduce the error, and after the error is reproduced, exit theMetaXpress Software.

9. Double-click the AxoTrace Software icon in the taskbar.

10. In the AxoTrace window, click File > Save As.

11. In the Save As dialog, in theName field, navigate to the location where you want to save
the log file, type the file name (for example, axotrace log.txt), and then click Save to save
the log file.

12. Click File > Exit to close the AxoTrace window.

13. Send the AxoTrace Software log as an email attachment to Molecular Devices Technical
Support. See Obtaining Support on page 149.
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Creating a System Information Report

Much of the required system setting information can be obtained by creating a System
Information Report. You can create this report from the About MetaXpress dialog using the
following procedure.

1. In theMetaXpress Software, click Help > About MetaXpress.

2. In the About MetaXpress dialog, in the fields on the right, type your contact
information.

Figure 8-7: About MetaXpress Software

3. Click Print Report.

4. In the Print Setup dialog, select to print to a PDF file or to a text file and then click OK.

5. Send the report file to appropriateMolecular Devices support personnel as an email
attachment.
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Appendix A: Instrument Specifications

The instrument must be installed on a level and stable surface. For additional specifications,
refer to the Pre-Installation Guide.

WARNING! If the instrument is used in a manner not specified by Molecular
Devices, the protection provided by the equipment might be impaired.

WARNING! The ImageXpress Nano System is an Equipment Class 1 product that
relies on protective earth grounding for safe operation. Any interruption of the
protective earth ground conductor, inside or outside the instrument, or
disconnection of the protective earth ground terminal can result in personal
injury.

WARNING! Do not position the equipment so that it is difficult to operate the
power switch on the front of the ImageXpress Systems Power and Options
Controller.

Figure A-1: Front and Sideways Installation Space Requirements

A
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Item Description

Operating environment Indoor use only

Systems power and options controller input 100 VAC to 240 VAC, 50/60 Hz, 12 amps
maximum 

Light source power 220 W, 24 V, AC to DC converter included

Computer power input 100 VAC to 240 VAC, 50/60 Hz

Computer monitor power input 100 VAC to 240 VAC, 50/60 Hz

Weight, base unit instrument, no options 93 kg (205 lbs.)

Weight, external light source 7 kg (16 lbs)

Weight, external system power and options controller
no options

10 kg (22 lbs)

Weight, computer and monitor 16 kg (35 lbs)

Ambient operating temperature 18°C to 30°C

Humidity restrictions 35% to 50% non-condensing

Altitude restrictions Not to exceed 2000 m (6562 ft)

ISM Equipment class 1

IEC Installation category II

IEC Pollution degree 2

IEC Ingress Protection IP20

Table A-1: Operational and Environmental Specifications for the Instrument Without
Options
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Instrument Dimensions

Figure A-2: Instrument Height, Width, and Length

Figure A-3: Distance Between the Outside Edges of the Instrument Feet
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Appendix B: Compatible Objectives

The following table details the Nikon objectives that are compatible with the
ImageXpress Nano System. It also provides microplate compatibility information for the
objectives used in the system.

Objective Magnification and
Type

Molecular Devices
Part Number

Numerical
Aperture (NA)

Working
Distance

Plate Compatibility

2x Plan Apo Lambda 1-6300-0451 0.10 8.5 mm Thin bottom
(0.17 mm),
Thin bottom
(0.17 mm) No Skirt,
Thick bottom
(0.25 mm to 1 mm)

4x Plan Apo Lambda 1-6300-0121 0.20 20 mm Thin bottom
(0.17 mm),
Thin bottom
(0.17 mm) No Skirt,
Thick bottom
(0.25 mm to 1 mm)

10x Plan Fluor 1-6300-0190 0.30 16.0 mm Thin bottom
(0.17 mm),
Thin bottom
(0.17 mm) No Skirt,
Thick bottom
(0.25 mm to 1 mm)

20x Super Plan Fluor ELWD cc
0 mm to 2 mm

6500-0108 0.45 8.1 mm to
7.0 mm

Thin bottom
(0.17 mm)*,
Thin bottom
(0.17 mm) No Skirt*,
Thick bottom
(0.25 mm to 1 mm)

40x Super Plan Fluor ELWD cc
0 mm to 2 mm

6500-0109 0.60 3.7 mm to
2.7 mm

Thin bottom
(0.17 mm)*,
Thin bottom
(0.17 mm) No Skirt,
Thick bottom
(0.25 mm to 1 mm)

Table B-1: Nikon Objectives Compatible with the ImageXpress Nano System and Settings

B
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Objective Magnification and
Type

Molecular Devices
Part Number

Numerical
Aperture (NA)

Working
Distance

Plate Compatibility

60x Super Plan Fluor ELWD cc 0.1
mm to 1.3 mm

6500-0110 0.70 1.8 mm to
2.62 mm

Thin bottom
(0.17 mm)*,
Thin bottom
(0.17 mm) No Skirt3

Thick bottom
(0.25 mm to 1 mm)

Table B-1: Nikon Objectives Compatible with the ImageXpress Nano System and Settings (continued)

*20x and 40x ELWD image through cover slips, but other objectives give better resolution and shorter
exposures.
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Appendix C: Filter Specifications

Filter Wavelengths Shading Correction Plate

DAPI Excitation: 377/50 nm
Emission: 447/60 nm
Dichroic: 409 nm

Green
Pink

CFP Excitation: 438/24 nm
Emission: 483/32 nm
Dichroic: 458 nm

Pink

GFP Excitation: 472/30 nm
Emission: 520/35 nm
Dichroic: 495 nm

Pink
Red

FITC Excitation: 474/27 nm
Emission: 525/45 nm
Dichroic: 495 nm

Pink
Red

YFP Excitation: 500/24 nm
Emission: 542/27 nm
Dichroic: 520 nm

Pink
Red

TRITC Excitation: 543/22 nm
Emission: 593/40 nm
Dichroic: 562 nm

Red

Cy3 Excitation: 531/40 nm
Emission: 593/40 nm
Dichroic: 562 nm

Green

Texas Red Excitation: 562/40 nm
Emission: 624/40 nm
Dichroic: 593 nm

Red

Cy5 Excitation: 628/40 nm
Emission: 692/40 nm
Dichroic: 660 nm

Red

Table C-1: Filter Specifications for the ImageXpress Nano System

C
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Appendix D: Replacement Parts and Optional Extras

For an up-to-date list of replacement parts and optional extras, see the website at:
www.moleculardevices.com

Part Number Description

— For a List of Compatible Nikon Objectives see Compatible Objectives on page
159

1-6300-0442 DAPI Filter Set

5045173 FITC Filter Set

1-6300-0444 TRITC Filter Set

1-6300-0445 Cy3 Filter Set

1-6300-0446 Cy5 Filter Set

1-6300-0447 CFP Filter Set

1-6300-0448 YFP Filter Set

1-6300-0449 Texas Red Filter Set

1-6300-0450 GFP Filter Set

5048412 Accessory Tool Kit

5033647 Replacement Solid-State Light Source

1-3335-0005 12 V Halogen Lamp for Nikon Transmitted Light (TL) Tower

Table D-1: Replacement Parts and Optional Extras for the ImageXpress Nano System

D

http://www.moleculardevices.com/
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Appendix E: File Privileges for the MetaXpress Software

This appendix describes which directories must be accessible to MetaXpress Software
administrators and users.

Note: The following information assumes that theMetaXpress Software has been
installed to the default path of C:\MX6.

Note: There are no restrictions as to where the software is installed. Nothing prevents
installing the software to the path of C:\Program Files\MX6.

Note: When your system has multiple configurations and multiple groups not named
MetaXpress, substitute the appropriate group name for the default group name
MetaXpress as needed in the following list of folder paths.

Software Administrator
Read/write access is required for everything under the C:\MX6 tree. The Software
Administrator also needs to create and periodically modify shading correction images in the
C:\Shading Images folder. Because this is a possible security violation, this operation can be
accomplished by the System Administrator so that the Software Administrator is not given
write access to the root directory.

Standard Users
Read Only access needed:

C:\MX6

C:\MX6\app\mmproc

C:\MX6\app\mmproc\Dropins

C:\MX6\Help - all subdirectories -

C:\MX6\Groups\

If the system is set up for multiple users:

C:\MX6\Groups\MetaXpress

C:\MX6\Groups\MetaXpress\Users

If the system is an acquisition computer:

C:\MX6\Hardware\

C:\MX6\Hardware\ - all subdirectories -

E
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C:\MX6\Plates\

C:\MX6\Vinput\ - all subdirectories -

Read/Write and Modify Access needed:

C:\Analysis

C:\Assay

C:\Backup

CAUTION! Do not delete or rename the Backup folder from your system
computer. At the start of every plate acquisition, theMetaXpress Software
archives the current configuration and instrument settings to a date-stamped .zip
file in the C:\Backup\ folder. If your software configuration or instrument settings
get corrupted, you can restore the settings using the backup archives. Contact
Molecular Devices Technical Support for assistance.

C:\Shading Images

If the system is set up for a single user:

C:\MX6\Groups\MetaXpress

Note: Or appropriate group name, not necessarily calledMetaXpress.

If the system is set up for multiple users:

C:\MX6\Groups\MetaXpress\Users\Individual user
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Appendix F: Electromagnetic Compatibility

Regulatory for Canada (ICES/NMB-001:2006)
This ISM device complies with Canadian ICES-001.
Cet appareil ISM est confomre à la norme NMB-001 du Canada.

ISM Equipment Classification (Group 1, Class A)
This equipment is designated as scientific equipment for laboratory use that intentionally
generate and/or use conductively coupled radio-frequency energy for internal functioning,
and are suitable for use in all establishments, other than domestic and those directly
connected to a low voltage power supply network which supply buildings used for domestic
purposes.

Information to the User (FCC Notice)
This equipment has been tested and found to comply with the limits for non-consumer ISM
equipment, pursuant to part 18 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a non-residential installation. This
equipment generates, uses, and can radiate radio frequency energy and if not installed and
used in accordance with the instructions, might cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user
is encouraged to try to correct the interference by one or more of the following measures:

Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.

Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

Consult the dealer or an experienced radio/TV technician for help.

In order to maintain compliance with FCC regulations, shielded cables must be used with this
equipment. Operation with non-approved equipment or unshielded cables is likely to result
in interference to radio and TV reception. The user is cautioned that changes and
modifications made to the equipment without the approval of themanufacturer could void
the user's authority to operate this equipment.

F
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Index

A
A1 center

test 38

Abbé illumination system 14

accessory kit 28

Acquire Time Series acquisition option

defined 91

Acquire Z Series acquisition option

defined 91

acquired image

legacy shading correction for 89

acquisition

assay design 43

instrument maintenance 47

plate
batch consistency 46
bottom thickness 45
fluorescence 45
format 45
material 45
reproducibility of the Z pattern 45
selection 44

preparing 43

sample preparation 46
cell density 46
final buffer or media conditions 46
fixation and staining conditions 46
Plate handling and storage 47

setting up 49

acquisition protocol 56

configuring multi-well acquisitions 73

configuring post-acquisition analysis
options for 103

configuring the acquisition wavelengths
for 80

configuring the autofocus options for 75

configuring the journals for 99

configuring theMetaXpress desktop
appearance settings 107

saving 112

specifying the camera binning and gain
for 55-56

specifying the series acquisition options
for 91

viewing a summary of all current settings
for 111

acquisition settings

warning icons 54

acquisition wavelengths

configuring for an acquisition protocol 80

adaptive acquisition 66

settings 70

administrator 18

analysis 26

assay design

cell-based 44

fluorochromes 43

plates or slides 44

autofocus 15, 36, 41

settings 77

autofocus options

configuring for an acquisition protocol 75

AxoTrace Software log 151

B
binning 78

biological safety 11
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C
calibrate distances 34

camera

configuration options 77

magnification 55

settings 32

camera binning

specifying for an acquisition protocol 55

camera gain

specifying for an acquisition protocol 56

carbon dioxide

after set up 131

set up 130

tank 130

chemical safety 11

cleaning

instrument 142

safety 12

colors

status lights 25, 149

configure

acquisition protocol 107

adaptive acquisition 66

devices 28

hardware 29

magnification 34

multi-well acquisition 73

plate acquisition options 49

sites to visit 61

tab 53, 55

configure tab

objective and camera tab 55

correction collar

adjustment 143

critical illumination 14

customer support 149

D
data

acquire 26

data analysis 26

database

saving an acquisition protocol to 112

default data paths 119

dichroic

transmission spectrum 21

dimensions

instrument 157

display

setting options 108

tab 107

E
electrical safety 10

electromagnetic compatibility 167

electronics 16

ELWD

correction collar adjustment 143

EMC 167

environmental control 121

before running experiment 133

carbon dioxide tank set up 130

cleaning 133

hardware provided 122

sample plate loading 131

setting up 125

temperature set up 125

water reservoir set up 126

excitation 14, 20
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F
file

saving an acquisition protocol to 112

file privileges 165

filter cube 14

filters

specifications 161

fixation 46

fixed nuber of sites in each well

configure 63

fluorescence imaging 19

fluorochromes

selection 43

focusing

image-based 77

laser-based 77

H
hardware configuration 29

I
illumination

optics 14

Image-based focusing

defined 75

input power 156

install

system 27

instrument

dimensions 157

maintenance 26

specifications 155

status lights 25, 149

weight 156

intensity above local background gray
levels 72

interlocks

hardware 8

J
journals

acquisition steps 100

configuring for an acquisition protocol 99

K
koehler illumination 136

L
lamp

solid-state 142

Laser-based autofocusing

defined 75

laser autofocus

test 36

Laser Autofocus Wizard 37, 41, 57-60, 77, 84

legacy shading correction 42

light source 14, 23

maintenance 142

log

Axotrace Software 151

login 24

login dialog 24

M
magnification 55

magnification settings 34

maintenance 26

cleaning 142

menu map 17

MetaXpress

desktop appearance settings 107
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features 17

file privileges 165

settings 33

start 24

MetaXpress Software 14, 27

microplate

reference point 38

types 39

moving parts 10

multi-user mode 24, 113

multi-well plate 73

N
Nikon

objectives 15, 159

O
objective and camera

tab 55

objectives 21, 159

correct placement 143

correction collar adjustment 143

settings 28

Z stage 15, 28

optical path 19

optional expansion solutions 121

environmental control 121

transmitted light 134

optional hardware 163

P
panels

service 9

parts

ordering 163

plate

eject 52

load 52

map 52

multi-well 73

navigation 51

reference point 38

tab 56

types 39

plate acquisition

configuration options 49

Plate Acquisition Setup dialog

accessing 50

Configure tab, Acquisition tab 75

Configure tab, Display tab 107

Configure tab, Objective tab 55

Configure tab, Plate tab 56

Configure tab, Sites to Visit tab 61

layout of 51

Summary panel 111

plate dimensions 56

considerations for 59

plate reference point

test 38

post-acquisition analysis options

configuring for an acquisition protocol 103

power

on 23

supply 156

protective housing 8

protocol 51

load 51

save 53
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R
replacement parts 163

report

system information 153

requirements

experiment 43

run

tab 53

S
safety

before operation 8

biological 11

chemical 11

cleaning 12

electrical 10

information 7

interlocks 8

labels 8

moving parts 10

notices 7

symbols 8

sample stage 15, 28

save protocol 112

to database 112

to file 112

series acquisition options

configuring for an acquisition protocol 91

service panels 9

settings

verify and back up 33

shading correction

correcting for an acquired image 89

legacy 42, 89, 145

plates 28

setting options 88

simplified menu structure 17

single-user mode 24

single site in each well

configure 61

site map 52

sites to visit 61

adaptive acquisition 66

fixed number 63

multi-well 73

single site 61

tab 61

software

administrator 165

customize 113

default data paths 119

desktop icons 115

groups 113

offline 114

start 24

taskbars 117

toolbars 116

users 113

solid-state lamp 142

specifications

instrument 155

stage

objectives 15, 28

sample 15, 28

X-Y stage 15, 28

Z stage 15, 28

staining 46

start up 23

status indicators 25, 149
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status lights 25, 149

summary

experiment 54

panel 54

Summary panel

defined 111

system

administrator 18

components 14, 27

information report 153

installation 27

lights 25, 149

power on 23

settings 28

systems power 23, 156

T
taskbars 117

technical support 149

time point options

time series acquisition 106

Time series acquisition with Z series
acquisition for at least one
acquisition wavelength 106

Z series acquisition for at least one
acquisition wavelength 106

time series

configuring 92

timelapse

setting 92

setting options 93

toolbars 116

transmitted light 134

hardware 134

koehler illumination set up 136

light bulb replacement 138

turn on 23

W
water reservoir 126

wavelength

setting 82

setting options 83

tab 80

tools 53

weight

instrument 156

X
X-Y stage 15, 28

Z
Z series

configuring 95

setting options 96

Z stage 15, 28
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